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LECTURE-1: INTRODUCTION TO COMPUTERS, 

DEFINITION:HARDWARE, SOFTWARE AND FIRMWARE, TYPES 

OF SOFTWARE 

INTRODUCTION TO COMPUTERS: 

A Computer is an electronic device that can perform activities that involve Mathematical, 

Logical and graphical manipulations. Generally, the term is used to describe a collection of 

devices that function together as a system. It performs the following three operations in 

sequence. 

1. It receives data & instructions from the input device. 

2. Processes the data as per instructions. 

3. Provides the result (output) in a desired form. 

Data : It is the collection of raw facts, figures & symbols. 

Ex : Names of students and their marks in different subjects listed in random order. 

Information : It is the data that is processed & presented in an organized manner. 

Ex : When the names of students are arranged in alphabetical order, total and average marks 

are 

calculated& presented in a tabular form, it is information. 

Program : Set of instructions that enables a computer to perform a given task. 

Advantages of computers : 

1. High speed :Computers have the ability to perform routine tasks at a greater speed than 

human 

beings. They can perform millions of calculations in seconds. 

2. Accuracy : Computers are used to perform tasks in a way that ensures accuracy. 

3. Storage :Computers can store large amount of information. Any item of data or any 

instruction 

stored in the memory can be retrieved by the computer at lightning speeds. 

4. Automation :Computers can be instructed to perform complex tasks automatically ( which 

increases the productivity). 

5. Diligence : Computers can perform the same task repeatedly & with the same accuracy 

without getting tired. 

6. Versatility : Computers are flexible to perform both simple and complex tasks. 
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7. Cost effectiveness :Computers reduce the amount of paper work and human effort, 

thereby 

reducing costs. 

Limitations of computers : 

1. Computers need clear & complete instructions to perform a task accurately. If the 

instructions 

are not clear & complete, the computer will not produce the required result. 

2. Computers cannot think. 

3. Computers cannot learn by experience.  

Generations of computers : 

 

ANATOMY OF COMPUTERS 

The computer system consists of three units: 

1. Input device 2. Central Processing Unit (CPU) 3. Output device 
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Block diagram of a Computer 

 

The various functions of these units can be summarized as: 

Unit Function 

1.Input device : Reads information from input media and enters to the 

computer in a coded form 

2.CPU  

(a) Memory unit : Stores program and data 

(b) Arithmetic Logic unit : Performs arithmetic and logical functions 

(c) Control Unit : Interprets program instructions and controls the input and 

output devices 

3. Output device : decodes information and presents it to the user 

 

Central Processing Unit: It is the part of the computer that carries out the instructions of 

acomputer program. It is the unit that reads and executes program instructions. Hence it is 

known as the “brain” of the computer. The CPU consists of storage or memory unit, 

Arithmetic Logic Unit (ALU) and control unit. 

(a). Memory Unit: It is also known as the primary storage or main memory. It stores data, 

program instructions, internal results and final output temporarily before it is sent to an 

appropriate output device. It consists of thousands of cells called  “storage locations”. These 

cells activate with “off-on”or binary digits(0,1) mechanism. Thus a character either a letter or 

numerical digit is stored as a string of (0,1) Binary digits ( BITS). These bits are used to store 

instructions and data by their combinations. 

(b) Arithmetic and Logical Unit(ALU): It is the unit where all Arithmetic operations 

(addition, subtraction etc.) and logical functions such as true or false, male or female are 
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performed. Once data are fed into the main memory from input devices, they are held and 

transferred as needed to ALU where processing takes place. No process occurs in primary 

storage. Intermediate generated results in ALU are temporarily placed in memory until 

needed at later time. Data may move from primary memory to ALU and back again to 

storage many times before the process is finalized. 

(c).Control Unit :It acts as a central nervous system and ensures that the information is 

stored 

correctly and the program instructions are followed in proper sequence as well as the data are 

selected from the memory as necessary. It also coordinates all the input and output devices of 

a system . 

 

HARDWARE and SOFTWARE 

Hardware: The physical components of the computer are known as ―Hardwareۅ. It refers to 

the objects that we can actually touch. 

Ex: input and output devices, processors, circuits and the cables. 

Software: Software is a program or set of instructions that causes the Hardware to function in 

a desired way. The basic difference between the Hardware and Software is just the same as 

that exists between TV and TV studio. Without TV studio (software) from where the 

programs are telecast, the TV (Hardware) is a dead machine. 

There are four categories of software. They are: 

1. Operating System 2. Utility programs 3. Application programs 

4. General purpose programs 

1. Operating System (OS) :The software that manages the resources of a computer system 

andschedules its operation is called Operating system. The operating system acts as interface 

between the hardware and the user programs and facilitates the execution of programs. 

Generally the OS acts as an interface between the user and the Hardware of the computer. i.e 

It is a bridge between the user and the Hardware. 

The User interface provided by the OS can be character based or graphical. 

CUI -- Character user Interface 

GUI -- Graphical user Interface 

CUI : It is operated with keyboard only. Ex: MS-DOS, UNIX 

GUI : The system can be operated with mouse and keyboard. Ex: Windows 95, Windows XP 

etc 
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 Disk Operating System (DOS): It was developed as early as 1980 by Bill Gates at the age 

of 

19. It is suited for personal computers. Dos is a single user and single task operating system 

 WINDOWS : It works with DOS and it supports single user and multitask system. It 

requires a powerful PC with a minimum RAM of 8 MB . 

 UNIX ,XENIX AND LINUX: It is suited for multi-user and multi-task system 

2. Utility Programs: These are pre-written programs supplied by the manufacturer for 

maintaining day to day activities of computer system. 

Example: COPY, SORT, MAILING, virus scanning software etc., 

3.Application Programs: These are user written programs to do a specific job which can be 

changed tomeet the individual needs. These programs are written in different languages such 

as BASIC or C or by using database packages like dBASE, Oracle. 

Example: Payroll, Billing, Railway Reservation etc. 

4. General Purpose Packages: These packages are developed to suit the needs of research 

workers / scientists in different fields. These packages are categorized as : 

i) Data Analysis ii) Word Processing iii) Spread Sheet iv) Graphics and v) Databases 

Data Analysis 

Ex: SPSS (Statistical Package for Social Science), 

MSTAT, MICROSTAT, GENSTAT, SAS etc. 

Word Processing 

Ex: WORD PERFECT, WORDSTAR, MS-Word, CHIRATOR, NORTON EDITOR etc. 

Spread Sheet 

Ex: LOTUS, Qpro, VP-PLANNER, SYMPHONY, MS-Excel etc. 

Graphics 

Ex: LOTUS, STORY-BOARD, POWER-POINT etc. 

Databases 

Ex: dBASE, FOX-BASE, FOX-PRO, ORACLE, MS-Access etc. 

 

FIRMWARE: 

Firmware is a software program permanently etched into a hardware device such 

as a keyboards, hard drive, BIOS, or video cards. It is programmed to give 

permanent instructions to communicate with other devices and perform functions 

like basic input/output tasks. Firmware is typically stored in the flash ROM (read 
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only memory) of a hardware device. It can be erased and rewritten. Without 

firmware, a hardware device would be non-functional. 
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LECTURE 2: DATA REPRESENTATION, BINARY AND 
HEXADECIMAL NUMBER SYSTEM, ASCII AND UNICODE 

Data Representation: 

a. Data refers to the symbols that represent people, events, things, and ideas. Data can be 

a name, a number, the colors in a photograph, or the notes in a musical composition.  

b. Data Representation refers to the form in which data is stored, processed, and 

transmitted. 

c. Devices such as smartphones, iPods, and computers store data in digital formats that 

can be handled by electronic circuitry 

d. Digitization is the process of converting information, such as text, numbers, photo, or 

music, into digital data that can be manipulated by electronic devices. 

e.  The 0s and 1s used to represent digital data are referred to as binary digits — from 

this term we get the word bit that stands for binary digit. 

f. A bit is a 0 or 1 used in the digital representation of data. 

g. A digital file, usually referred to simply as a file, is a named collection of data that 

exits on a storage medium, such as a hard disk, CD, DVD, or flash drive. 

Number systems: 

Two types of number systems are:  

a.  Non-positional number systems 

b. Positional number systems 

Non-positional Number Systems 

Characteristics  

a.  Use symbols such as I for 1, II for 2, III for 3, IIII for 4, IIIII for 5, etc 

b.  Each symbol represents the same value regardless of its position in the number   

c. The symbols are simply added to find out the value of a particular number 

Difficulty 

a. It is difficult to perform arithmetic with such a number system 
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Positional Number Systems 

Characteristics   

a. Use only a few symbols called digits 

b. These symbols represent different values depending on the 

number. 

 

Types of Positional Number Systems:

1. Decimal Number System 

2. Binary Number System 

3. Octal Number System 

4. Hexadecimal Number System

 

1. Decimal Number Systems

Characteristics 

 A positional number system § Has 10 symbols or digits 

its base = 10  

 The maximum value of a single digit is 9 (one less than the value of the base)

 Each position of a digit represents a specific power of the base (10) 

 We use this number system in our day

2. Binary Number System 

Characteristics 

 A positional number system 

 Has only 2 symbols or digits (0 and 1). Hence its base = 2

 The maximum value of a single digit is 1 (one less than the value of the base)

 Each position of a digit represents a specific power 

 This number system is used in computers
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These symbols represent different values depending on the position they occupy in the 

Types of Positional Number Systems: 

Hexadecimal Number System 

Decimal Number Systems 
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Each position of a digit represents a specific power of the base (2) 
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position they occupy in the 

(0, 1, 2, 3, 4, 5, 6, 7, 8, 9). Hence, 

The maximum value of a single digit is 9 (one less than the value of the base) 

 

The maximum value of a single digit is 1 (one less than the value of the base) 
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3. Hexadecimal Number System 

Characteristics  

 A positional number system  

 Has total 16 symbols or digits (0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F). Hence its 

base = 16 

 The symbols A, B, C, D, E and F represent the decimal values 10, 11, 12, 13, 14 and 

15 respectively  

 The maximum value of a single digit is 15 (one less than the value of the base) 

 Each position of a digit represents a specific power of the base (16)  

 Since there are only 16 digits, 4 bits (24 = 16) are sufficient to represent any 

hexadecimal number in binary 

 

Converting a Number of Another Base to a Decimal Number: 

Method  

Step 1: Determine the column (positional) value of each digit 

 Step 2: Multiply the obtained column values by the digits in the corresponding columns  

Step 3: Calculate the sum of these product 

Numericals: 

1. Convert (10101111)2 into its decimal form 
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Position 7 6 5 4 3 2 1 0 

Bit value 1 0 1 0 1 1 1 1 

 

(10101111)2 = 1 × 2଻ +  0 × 2଺ +  1 × 2ହ + 0 × 2ସ + 1 × 2ଷ +  1 × 2ଶ +  1 × 2ଵ + 1 × 2଴ 

                       = 128+0+32+0+8+4+2+1 

                      =(175)10 

Converting a Decimal Number to a Number of Another Base 

Division-Remainder Method  

Step 1: Divide the decimal number to be converted by the value of the new base Step  

2: Record the remainder from Step 1 as the rightmost digit (least significant digit) of the new base 

number  

Step 3: Divide the quotient of the previous divide by the new base 

Step 4: Record the remainder from Step 3 as the next digit (to the left) of the new base number 

Repeat Steps 3 and 4, recording remainders from right to left, until the quotient becomes zero in 

Step 3 

 Note that the last remainder thus obtained will be the most significant digit (MSD) of the new 

base number 
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CHARACTER ENCODING SYSTEMS:

1. ASCII: 

ASCII stands for American Standard Code for Information Interchange. It uses numbers to 

represent text. Digits (1,2,3, etc.), letters (a, b, c, etc.) and symbols (!) are called characters. When 

there is a piece of text, ASCII converts each character to a number. This set of numbers is easier 

to store into the computer memory. In simple words, assigning a number to a character is called 

encoding. 

For example, the upper case ‘A’ is assigned the number 65. Sim

Likewise, each character has a number in ASCII. The ASCII table contains all the characters with 

corresponding numbers. ASCII uses 7 bits to represent a character. Therefore, it represents a 

maximum of 128 (27) characters.

ASCII characters are used in programming, data conversions, text files, and graphic arts and 

in emails. The programmers can use ASCII to represent calculations on characters. The 

difference between the lower case and the upper case letter is always 32

ASCII value of ‘a’ is 97 and ‘A’ is 65. So, a 

letter is known, it is possible to find the ASCII value of corresponding uppercase or the 
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piece of text, ASCII converts each character to a number. This set of numbers is easier 

to store into the computer memory. In simple words, assigning a number to a character is called 
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ASCII stands for American Standard Code for Information Interchange. It uses numbers to 

represent text. Digits (1,2,3, etc.), letters (a, b, c, etc.) and symbols (!) are called characters. When 

piece of text, ASCII converts each character to a number. This set of numbers is easier 

to store into the computer memory. In simple words, assigning a number to a character is called 

ilarly, 65 refer to the letter ‘A’. 

Likewise, each character has a number in ASCII. The ASCII table contains all the characters with 

corresponding numbers. ASCII uses 7 bits to represent a character. Therefore, it represents a 

 

ASCII characters are used in programming, data conversions, text files, and graphic arts and 

in emails. The programmers can use ASCII to represent calculations on characters. The 

For example, the 

A = 32. Therefore, if the ASCII value of any 

letter is known, it is possible to find the ASCII value of corresponding uppercase or the 
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lowercase letter. Furthermore, ASCII is used in graphic arts to represent images using 

characters. 

One drawback of ASCII is that it can only represent 128 characters. It does not have 

representations for most mathematical and other symbols. 

2. UNICODE: 

Unicode is an alternative. It is maintained by Unicode Consortium. It covers a wide range of 

characters. It contains representations for letters in languages such as English, Greek, Arabic 

etc., mathematical symbols, emoji and many more. There are three types of encoding 

available in Unicode. They are UTF-8, UTF – 16 and UTF -32. UTF uses 8 bits per character, 

UTF-16 uses 16 bit per character and UTF-32 uses 32 bits for a character. In UTF-8, the first 

128 characters are the ASCII characters. Therefore, ASCII is valid in UTF-8. Usually, 

Unicode is used in internationalization and localization of computer software. This standard is 

also used in operating systems, XML, .NET framework and programming languages such as 

Java. 

 

 

 
 

BS Publication

Telegram - https://t.me/AgroMind

https://t.me/AgroMind


Agri-Informatics Lecture Notes 
 

Prof. N. K. Kulkarni Page 15 
 

LECTURE 3: PRIMARY, SECONDARY MEMORY, UNITS USED FOR 
MEASUREMENT OF MEMORY, INPUT OUTPUT DEVICES 
 

Memory or storage capacity is one of the important components of a computer. Any storage 

unit of a computer system is classified on the basis of the following criteria: 

1. Access time: This is the time required to locate and retrieve stored data from the storage 

unit in response to program instructions. 

2. Storage capacity: It is the amount of data that can be stored in the storage unit. 

3. Cost per bit of storage. 

Units of memory: The computer stores a character in the storage cells with binary (0,1) 

mechanism.Thus the basic unit of memory is a bit (binary digit – 0,1). To store a character, a 

computer requires 8 bits or 1 byte. This is called the  “word length” of the storage unit. Hence 

the storage capacity of the computer is measured in the number of words it can store and is 

expressed in terms of bytes. The different units of measurement are 

8 Bits = 1 Byte 

210 (or) 1024 Bytes = 1 Kilo Byte (KB) 

210 (or)1024 KB = 1 Mega Byte (MB) 

210 (or)1024 MB = 1 Gega Byte (GB) 

Types of Memory : A computer memory is of two types 

1. Primary Memory ( Internal storage) 2. Secondary Memory ( External storage) 

Primary Memory : Primary memory is also called internal memory and is an important part 

of a 

computer. It is the main area in a computer where the data is stored. The stored data can be 

recalled instantly and correctly whenever desired. This memory can be quickly accessed by 

the CPU for reading or storing information. Primary memory is further classified into two 

types: 

Random Access Memory (RAM) and Read- Only Memory (ROM ) 

RAM: 

RAM is also known as read/write memory as information can be read from and written onto 

it. RAM is a place in a computer that holds instructions for the computer, its programs and 

the data. The CPU can directly access the data from RAM almost immediately. However, the 

storage of data and instructions inRAM is temporary, till the time the computer is running. It 
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disappears from RAM as soon as the powerto the computer is switched off. i.e it is volatile 

memory. 

ROM: 

It is called Read-only memory as information can only be read from and not written or 

changed onto ROM. ROM is the ‘built-in‘ memory of a computer. It stores some basic input 

– output instructions put by the manufacturer to operate the computer. The storage of data 

and instructions in ROM is permanent. It does not depend on the power supply. i.e it is non-

volatile memory. 

Secondary memory: The primary memory which is faster (and hence expensive) is generally 

not sufficient for large storage of data. As a result, additional memory, called the  “auxiliary” 

or “secondary memory” is used. It is also referred as “backup storage” as it is used to store 

large volume of data on a permanent basis which can be transferred to the primary memory 

whenever required for processing. Data are stored in secondary storage in the same binary 

codes as in the main (primary memory) storage. 

Some of the devices of secondary storages are Floppy Disk, Hard Disk, CD-ROM, DVD and 

Flash drive. 

1. Floppy Disk: It is also referred as Diskette and is made of flexible Vinyl material. It 

has a small hole on one side called “Right protect notch”, which protects accidental 

writing/deleting the information from the disk. There is a hole in the centre through 

which the spindle of drive unit rotates the disk. The disks are available in two sizes of 

5.25 and 3.5 inches and these could be either low density or high-density floppies. 

Storage capacity of floppies is measured in kilobytes (KB) and megabytes (MB). The 

details about the storage capacities of the floppies are presented below: 

 

2. Hard Disk: The hard disk can hold more information than the floppy disk and the retrieval 

of 

information from hard disk is faster when compared to floppies or tapes. A hard disk is fixed 

inside theCPU and its capacity ranges from 20 MB onwards. The hard disk is made up of a 

collection of discs(one below the other) known as platters on which the data is recorded. 
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These platters are coated with magnetic material. It is less sensitive to external environmental 

disorders and hence the storage in hard disk is safe. A small hard disk might be as much as 25 

times larger than a floppy disk. Storage Capacity of hard disks varies from 20 MB to several 

Gega bytes like 80GB, 160GB. 

3. CD-ROM: CD-ROM stands for Compact Disk–Read Only Memory. It is used to store a 

wide variety of information. Its main advantage is that it is portable and can hold a large 

amount of data. The storage capacity of most CD-ROMs is approximately 650 MB or 700 

MB. 

CD-ROMs have the following variations: 

(i) CD-R(Compact disc Recordable): Data can be written onto it just once. The stored data 

can be read. Data once written onto it cannot be erased. 

(ii) CD-RW(Compact disc Rewritable): It is also called erasable CD. Data once written onto 

it can be erased to write or record new information many times. 

To use a CD-ROM, a device called CD drive is needed. 

4. DVD: DVD stands for Digital Versatile Disc. It is similar to a CD-ROM, except that it can 

store larger amounts of data. The storage capacity of a DVD is at least 4.7MB. DVDs that can 

store up to 17GBs are also available. Because of their capacity, DVDs are generally used to 

store a very large multimedia presentations and movies that combine high quality sound and 

graphics. 

5. Flash Drive: It is a small, portable device that can be used to store, access and transfer 

data. Due to its small size, it is commonly called Pen drive. It is also called USB drive. We 

can read, write, copy, delete, and move data from computer to pen drive or pen drive to 

computer. It comes in various storage capacities of 2GB, 4GB, 8GB etc. It is popular because 

it is easy to use and small enough to be carried in a pocket. This device is plugged into the 

USB port of the computer and the computer automatically detects this device.  
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DISTINGUISH BETWEEN PRIMARY AND SECONDARY MEMORY 
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DISTINGUISH BETWEEN RAM AND ROM 
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Input Devices 

Devices used to provide data and instructions to the computer are called Input devices. 

Some important input devices are Key board, Mouse, Scanner, MICR, Web camera, 

Microphone etc. 

1. Keyboard: The Key board is used for typing text into the computer. It is also known as 

standard Input device. A computer keyboard is similar to that of a type writer with additional 

keys. The most commonly available computer keyboard has 104 keys. 

There are different types of keys on the keyboard. The keys are categorized as : 

 Alphanumeric keys , including letters & numbers. 

 Punctuation keys, such as colon (:), semicolon (;) Question mark (?), Single & double 

quotes (‘,”) 

 Special keys such as arrow keys, control keys, function keys (F1 to F12), HOME, END 

etc. 

2..Mouse: It is a device that controls the movement of the cursor on a monitor. A mouse will 

have 2 buttons on its top. The left button is the most frequently used button. There will be a 

wheel between the left and right buttons. This wheel enables us to smoothly scroll through 

screens of information. As we move the mouse, the pointer on the monitor moves in the same 

direction. Optical mouse is another advanced pointing device that uses a light emitting 

component instead of the mouse ball. Mouse cannot be used for entering the data. It is only 

useful to select the options on the screen. 

3. Scanner: : It is an input device that can read text or illustrations printed on paper and 

translate into digital form. The main advantage of these scanners is that the data need not be 

entered separately resulting in saving lot of time. 

Scanners are of two types: i) optical scanners ii) MICR 

i) Optical scanners: 

a. Optical character Recognition(OCR): In this, characters are read with the help of a light. 

This is used in office atomization, documentation in library etc. 

b. Optical mark recognition(OMR): It is a technology where an OMR device senses the 

presence or absence of a mark such as a pencil mark. OMR is used in tests such as aptitude 

tests. 

c. Optical barcode recognition(OBCR): Barcode readers are photoelectric scanners that read 

the barcodes or vertical zebra striped marks printed on product containers. This is used in 

super markets, bookshops etc. 
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4. Magnetic Ink Character Recognition(MICR): : It is a character recognition technology 

used primarily by the banking industry to facilitate the processing of the cheques. MICR 

characters ( chequeNo., Acc.No.etc) are printed in special ink usually containing iron oxide. 

When a document that contains the ink needs to be read, it passes through a machine which 

magnetizes the ink and there will be a reader sorter unit which translates the magnetic 

information into characters. MICR provides a secure, high speed of scanning and processing 

information. It scans about 2600 cheques/min. 

Output devices 

Any device that is capable of representing information on a computer is called an Output 

device. 

Output devices receive information from the CPU and present it to the user in the desired 

form. 

Some important Output devices are : Monitor, Printer 

1 .Terminal/Monitor: It is similar to TV screen- either a monochrome (black & white) or 

colour – and it displays the output. It is also referred as Visual Display Unit(VDU). Several 

types of monitors are in use. Some of them are Colour Graphic Adapter(CGA), Enhanced 

Graphics Adaptor(EGA) , Video Graphics Adapter (VGA) and Super Video Graphics 

Adapter (SVGA). 

The screen sizes differ from system to system. The standard size is 24 lines by 80 characters. 

Most systems have provision for scrolling which helps in moving the text vertically or 

horizontally on the screen. 

2 . Printer: A printer is used to transfer data from a computer onto paper. The paper copy 

obtained from a printer is often referred as “printout”. The different printers and their speeds 

are as follows:8888222501 
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LECTURE 4: OPERATING SYSTEMS. DEFINITIONS AND TYPES 
 

Operating system is a set of software that controls and manages hardware and basic 

system operations for a computer. The operating system loads programs into the 

computer's memory, runs these programs, and manages peripherals like disks and 

printers. 

 

Functions of Operating Systems: 

1. User Interface 

The user interface is the software layer, sometimes called the shell, through which 

the user communicates with the OS. The OS, in turn, communicates with the 

computer. Thus, the user interface includes the command processor, which loads 

programs into memory, as well as the many visual components of the operating 

system (what you see when you look at the display). 

2. Job Management 

Job management is an operating system function that controls the order and 

time in which programs are run. Two examples of programs that may perform 

this function are a scheduling program that schedules other programs or batch 

files to run on a certain day and time, and a print program that manages and 

prioritizes multiple print jobs. 

3. Task Management 

Task management is an operating system function found in multitasking 

operating systems. Multitasking implies that a computer is simultaneously 

running two or more programs (tasks) at the same time. In reality, a computer 

cannot run more tasks simultaneously than the number of processors that exist 

within the computer. In Windows, this application runs in the current window 

– the window that is on top of other windows on the screen and the window 

that receives input from the keyboard when the user types. 

4. Memory Management 

Memory management is an operating system function that manages the placement 

of programs and data in memory, while keeping track of where it put them. In the 

case of advanced operating systems, such as Windows XP and later Windows 

versions, this involves a scheme for making optimal use of memory 
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5. File Management 

File management, also referred to as data management, is an operating system 

function that allows the operating system to read, write, and modify data, while 

managing the logical storage of the data. Each operating system has at least one 

scheme of logical organization, called a file system. A file system is the logical 

structure used on a storage device for the purpose of storing files, as well as the 

code within an operating system that allows the OS to store and manage files on a 

storage device. 

TYPES OF OPERATING SYSTEMS: 

1. Single-User/Single-Tasking 

A single-user/single-tasking operating system is one that allows only a single user to 

perform a single task at a time. A task is a function such as reading a file from disk, 

performing a math calculation, printing a document, or sending a request over the 

Internet to a Web server. Small and simple OSs can only manage a single task at a 

time. Examples of single-tasking OSs are MS-DOS and the Palm OS, used on the 

palmOne handheld computers. 

2. Single-User/Multitasking 

An operating system that allows a single user to perform two or more functions at once is 

a single user/multitasking operating system. Early versions of both Microsoft Windows 

and the Macintosh operating systems were examples of this category 

3. Multiuser/Multitasking Operating Systems 

A multiuser/multitasking operating system allows multiple users to run programs 

simultaneously. We have had such operating systems for decades on mainframes and 

on today‘s network servers, sometimes called terminal servers. The desktop operating 

systems we survey in this book – Windows XP, Windows Vista, Windows 7, Linux, 

and Mac OS X – all are multiuser/multitasking operating systems with one caveat: 

only one user at a time can interactively log into the computer. However, a logged on 

user can simply log out, and leave their entire session of open applications and 

windows intact, and another user can log in and run a separate session, thus switching 

the current user. Therefore, Windows OSs support multiple but not simultaneous 

interactive users. 
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4. Real-Time Operating Systems 

A real-time operating system (RTOS) is a very fast and relatively small OS. Often 

embedded, meaning it is built into the circuitry of a device and not normally loaded from 

a disk drive, a real-time operating system runs realtime applications. It may support 

multiple simultaneous tasks or it may only support single tasking. A real-time application 

responds to certain inputs extremely quickly – thousandths or millionths of a second 

(milliseconds or microseconds, respectively). They run medical diagnostics equipment, 

life-support systems, machinery, scientific instruments, and industrial systems. Real-time 

OSs are used in aviation and aerospace where the code must run within the allotted time. 

Examples of real-time operating systems include BlueCat Linux by LynuxWorks, QNX 

Neutrino by QNX Software Systems, Operating System Embedded (OSE), pSOS, and 

Windows CE. 
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LECTURE 5: FILE MANAGEMENT 

File Management 

An operating system must provide a number of operations associated with files so that users can 

safely store and retrieve data. Typical operations are: Open, Close, Create, Copy, Rename, List. 

In addition, operations on single data elements within a file are supported by: Read, Write, Seek.  

File Control Blocks: File control blocks (FCB), sometimes referred to as file descriptors, are data 

structures that hold information about a file. When an operating system needs to access a file, it 

creates an associated file control block to manage the file. The structure of the file control block 

differs between operating systems, but most file control blocks include the following parts:  

• Filename 

• Location of file on secondary storage 

• Length of file 

• Date and time or creation or last access.  

a. File names 

Each operating system uses a specific convention or practice for naming files. MS-

DOS Uses eight character file names, a dot, then a three-character extension that 

denotes the type of file. Filenames are not case-sensitive. UNIX Filenames can be up 

to 254 characters long and are case-sensitive. Windows Filenames can be up to 255 

characters long and are not case-sensitive.   

b. File types 

File types refer to classifying the content of the file, such as a program, text file, 

executable program or data file. In Windows operating systems, the file type is 

derived from the filename extension. Typical file types and their extensions are: 

File Extension File Type 

.bas basic source program 

.c c source program 

.dll system library 

.doc/.docx Word document 

.exe executable program 

.txt text file 

.mp3/.wav Music Player Format 

.mp4/.flv/.3gpp Video File Format 

 

c. Track of files 
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The hard disk is comprised of a large number of sequentially numbered sectors. As 

files are created, free sectors are allocated to hold the file contents and marked as 

allocated. To keep track of the sectors and whether they are allocated or free, and to 

which file they belong, the operating system maintains a number of tables. 

d. Root file system 

When the operating system is first installed, it creates a root file system on the disk 

that specifies how many sectors are available and how they will be allocated. The root 

file system is a table of entries like a directory. In general, this is a fixed size, and 

once full, no more entries can be added. Each entry can be either a file or another 

directory table. The following table depicts this structure 

 

e. File systems supported by Windows operating systems 

The Windows operating system supports the following file systems: 

FAT The MS-DOS operating system introduced the File Allocation Table system 

of keeping track of file entries and free clusters. Filenames where restricted 

to eight characters with an addition three characters signifying the file type. 

The FAT tables were stored at the beginning of the storage space. 

FAT32 An updated version of the FAT system designed for Windows 98. It supports 

file compression and long filenames 

NTFS Windows NT introduced the NT File System, designed to be more efficient 

at handling files than the FAT system. It spreads file tables throughout the 

disk, beginning at the center of the storage space. It supports file 

compression and long filenames. 
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LECTURE 6: APPLICATIONS USED FOR DOCUMENT CREATION 
AND EDITING, DATA PRESENTATION USING SLIDES 
 

WORD PROCESSING 

Definition: Word-processing is essentially typing, editing, and manipulation of a document in 

a desired 

form. 

Units of the Document: 

Since word-processing is concerned with preparation of a document (in a desired form), it is 

essential to know the units of the document: 

1. Character: It refers to the alphabets, numerical digits, punctuations and other special 

symbols which are commonly used in the text. 

2. Word: A word is group of characters that are separated from other group of characters by 

some delimiters like, comma, full stop and space. 

3. Sentence: A sentence is a group of words preceded and followed by appropriate delimiting 

characters. 

4. Paragraph: It is a group of one or more sentences, paragraphs are separated by leaving 

blank lines between them. 

5. Pages: It is the amount of text that can be printed on one page of a paper. 

6. Chapters: It is a collection of pages 

7. Documents and files: It is a group of chapters. Usually, a complete document may be very 

short such as a memo(or letter) or very long such as a book consisting of several chapters. 

These documents are referred as “Files”. 

Features of Word-processing: 

1. Word-wrap 

2. cursor control 

3. editing 

4. formatting 

5. spell-check 

6. thesaurus 

7. macros 

8. printing 

9. file management 

10. mail merge printing 
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Word-processing Packages: Several word-processing packages are available. Some of these 

are listed 

below: 

1. MSWORD (SOFT WORD) 2. WORDSTAR 3. CHIRATOR 4. NORTON EDITOR 

MS-WORD 

MS- Word is a word processor. The extension name of MS- word is .doc. It is an 

application used to create, edit, print and save a document. It allows the user to insert 

pictures, tables, charts, drawings &features that will make the text richer & more 

interactive. 

( The term document refers to a file created using word processor) 

Starting MS-Word: 

Start ----All Programs ----MS-office----MS-word 

MS-word icon is W. 

Microsoft Word uses a toolbar and a main ribbon to allow you to modify your document. 

Within this ribbon, you can switch between tabs to determine what you would like to do. 

These tabs include Home, Insert, Design, Layout, References, Mailing, Review, and View. 

These tool bar and these tabs are discussed in more detail below. 

The Home Tab (Figure 5) is Microsoft Word’s standard view. This is the view most widely 

used and allows you to format text by Font Style, Font Size, Bold, Italic, Underline, 

Alignment, Numbered List, Bulleted List, Indentation, Spacing, and Font Color. 

 

The Insert Tab (Figure 6) contains any additives you want to place in your document, 

including but not limited to: Tables, Online Picture/Clip Art searches, Headers, and Footers. 

These icons are convenient and will bring up a dialogue box to give you further options when 

clicked. 

 

The Layout Tab (Figure 8) contains icons for page setup and paragraph actions, such as 

Margin, Orientation, Size and Columns. 
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The Review Tab (Figure 11) is where one can find Spelling & Grammar, the built in 

Thesaurus and Dictionary, you can Track Changes, Check Word Count, and Show/Add 

Comments 

 The View Tab (Figure 12) allows you to change the views of your document. 

 

Formatting The Document: The default page margins for Microsoft Word 

documents are 1 inch, but you may want to change them for a project.To change the page 

margins, go to Layout > Margins button. The Margins button with display a dropdown menu 

that shows some margin presets. If you wish to set different margins, select Custom Margins. 

A menu will appear where you can type irregular Margins (Figure 13). 

 

Formatting Paragraphs  

To format your paragraph, first highlight the paragraph you wish to format. To highlight ore 

than one paragraph, click at the beginning of the paragraph and drag the mouse over the text. 

To apply changes to the entire document select all by pressing Command + A. To specify 
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Alignment, Line Spacing, Indentation, and Page Break utilize the various options of the 

Home Tab or go to Format > Paragraph. This will Open up the Paragraph menu (Figure 14). 

 

 

Cut, Copy, and Paste 

You can use the Cut, Copy, and Paste features of Word to change the order of sections within 

your document, to move sections from other documents into new documents, and to save 

yourself the time of retyping repetitive sections in a document. Cut will actually remove the 

selection from the original location and allow it to be placed somewhere else. Copy allows 

you to leave the original selection where it is and insert a copy elsewhere. Paste is used to 

insert whatever has been cut or copied.  

To Cut or Copy:  

Highlight the text by clicking and dragging over the text to be cut or copied. Go to Home Tab 

> Clipboard Box > Copy (Command + C) or Home Tab > Clipboard Box > Cut (Command + 

X). Click the location where the information should be placed. To go Home Tab > Clipboard 

Box > Paste (Command + V). The clipboard box is shown in Figure 15. 

 

Formatting Text  
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Before you type, you should select your font style, size, color and attributes (such as bold, 

italic and underline) in the Home Tab. You can expand the Font Menu box to get more 

options by clicking Format > Font (Command + D) (Figure 16). However, if you wish to 

change text that has already been typed, click and drag over the text to be changed to 

highlight it and change it as before. 

 

 

Numbered and Bulleted Lists  

To create a simple numbered or bulleted list, click on the Numbering or Bullet button on the 

Paragraph toolbar in the Home Tab (Figure 17). To have more control over the format of your 

list, click the down arrows beside each style of list. Type the first item in the list and press Return 

to move to the next number or bullet. Press Return twice to exit the list. Press Tab to indent and 

move to the next level of your list. Press Shift + Tab to move back a level. 

 

Headers and Footers  

Headers and Footers can be used to give a uniform look to the pages of your document. To create 

one, go to Insert Tab > Header or Insert Tab > Footer. When clicking either button, a drop down 

menu with presets will show. If you wish to edit your own settings click either the Edit Header or 

Edit Footer buttons (Figure 19). If you wish to delete the header or footer you placed in your 

document, simply click Delete Header or Delete footer on the buttons drop down menu. 
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INSERTING AND ADDING OBJECTS 

There are many different elements that could be added to your word document. To find these 

various options, go to the Insert Tab. Some of the most commonly used elements are Tables, 

Pictures, Shapes, Charts, and Word Art. How to use these elements will be discussed in more 

detail below. 

Table  

To insert a table, go to the Insert Tab > Table. This will display a box where you can select how 

many columns and rows you would like your table to be by hovering over them (Figure 20). For 

more detailed options, click Insert Table. This will bring up the insert table display box. Here you 

can specify how many rows and columns the table has as well as how the content fits into the 

boxes (Figure 21). 
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Pictures  

To insert a picture, go to the Insert Tab > Pictures > Picture from File. This will bring up a file 

locator where you can navigate to where the picture you would like to insert is saved (Figure 22). 

Once you have found your photo, select the file and then click Insert. 
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Shapes 

To insert a shape, go to the Insert Tab > Shapes. This will bring up a menu of shapes that you can 

select from (Figure 23). Once you have found the shape you would like to insert, single click the 

shape to select it. Then you will click and drag in the document to draw your shape. 

 

Charts  

To insert a chart, go to the Insert Tab > Then click on the small box with 3 ColumsThis will bring 

up subcategories of chart types. When you hover over a category, the charts avaliable will display 
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on the right side with a new pop out menu. When you have found the chart you would like to 

insert, single click the chart (Figure 24). This will place a chart in word that displays. It will also 

open up Microsoft Excel with the data for you to go in and change the content. As you change the 

content in Excel, the content in Word will change automatically. 

 

 

WordArt  

Microsoft Word has a library of stylized text called WordArt. To insert WordArt, go to the Insert 

Tab > WordArt. This will bring up a quick menu of all the styles you can choose from (Figure 

25). Select one of the options and single click it. This will place an editable text box in your 

document. 

 

PRINTING 

Print Preview  

Before you print your document, you may want to preview it to make sure you are happy with the 

page layout and appearance of your document. To do this, in the toolbar click File > Print. This 

opens a preview of your document (Figure 26). In the preview, you have the options to choose the 

printer, select preset settings, decide the number of copies to be printed, as well as select a single 

or range of pages from an entire document to print. If you need to make changes to your 

document at this point, click Cancel in the bottom right corner of the dialog box. 
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Printing  

To print your document, go to File > Print. When your document looks how you want it and all 

the settings are put in, click Print in the bottom right corner. 

 

Saving as a PDF 

To save your document in the PDF file format, go to File > Save As. The saving dialog box 

(Figure 27) will appear where you can rename your document, select the saving destination, and 

select the file format of the document. 
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Click on Word Document (.docx) to access the file format drop down menu. In this drop down 

menu, select PDF. Once PDF is visible in the file format selection box, click Save. 

OTHER HELPFUL FUNCTIONS 

Undo and Redo  

The easiest way to undo an action is with the key commands Command + Z and to redo an action 

with Command + Y. It is important to note that not all actions are undoable, thus it is important to 

save before you make any major changes in your document. You also can find the Undo and 

Redo icons (figure 28) above the Main Ribbon. The left icon is Undo and the right icon is Redo. 

 

Word Count  

To get an accurate word count of your document, go to Review Tab > Word Count.This willgie 

you the total number of words in your document (Figure 29). If you need to word-count a specific 

section, highlight that section first by clicking and dragging over it and then go to Review Tab > 

Word Count. 

 

Quitting  

Before you quit, it’s a good idea to save your document one final time. Go to Word > Quit Word 

or use the command keys Command + Q (Figure 30). This is better than just closing the window, 

as it insures your document quits correctly. 
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SHORTCUT KEYS FOR MICROSOFT OFFICE 
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CREATING PRESENTATION USING SLIDES 

Opening PowerPoint 2013 

When you open PowerPoint 2013 for the first time, the Start Screen will appear. From here, 

you'll be able to create a new presentation, choose a template, and access your recently 

edited presentations. 

1. From the Start Screen, locate and select Blank Presentation. 

 

  

2. A new presentation will appear. 
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3. The Home tab gives you access to the most commonly used commands, including 

copy and paste, formatting, and the New Slide command. The Home tab is selected 

by default whenever you open PowerPoint. 

 

4. The Insert tab allows you to insert pictures, charts, tables, shapes, and videos, 

which can help you communicate information visually and add style to your 

presentation. 

 

5. You can apply themes from the Design tab. A theme is a predefined combination of 

colors, fonts, and effects that can quickly change the look and feel of your entire slide 

show. Different themes also include different slide layouts 

 

6. You can apply slide transitions from the Transitions tab. Transitions are the 

movements you see between slides when presenting your slide show. 

 

7. The Animations tab allows you to animate text and objects such as clip art, shapes, 

and pictures. Animations can be used to draw attention to specific content or make the 

slide easier to read. 
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8. When you're ready to present your slide show, the

make your presentation smooth and professional, including the option to 

timings and record narration

9. Backstage View 

Backstage view gives you various options for saving, opening, printing, and sharing 

your presentations. 

To access the backstage view, 
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When you're ready to present your slide show, the Slide Show tab gives you tools to 

make your presentation smooth and professional, including the option to 

narration. 

gives you various options for saving, opening, printing, and sharing 

To access the backstage view, Click the File tab on the Ribbon. 
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tab gives you tools to 

make your presentation smooth and professional, including the option to rehearse 

 

gives you various options for saving, opening, printing, and sharing 
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LECTURE 7: USE OF SPREADSHEETS FOR STATISTICAL 
ANALYSIS, EVALUATING MATHEMATICAL AND LOGICAL 
EXPRESSIONS 

Spreadsheet is a software that helps to substitute the paper worksheets in the offices. 

Spreadsheet displays data in the form of rows and columns. An intersection of row and 

column is known as a cell. 

MS-Excel is a window based spreadsheet developed by Microsoft corporation. It includes all 

features of a spreadsheet package like recalculation, graphs & functions. It also provides 

many Mathematical, Financial & Statistical functions. Thus it is used in many scientific and 

engineering environments for analyzing data. Excel can even hold graphic objects like 

pictures & images. 

Some important features of MS-Excel: 

1. Window based application: Excel like all other applications has Toolbars, Shortcut 

Menus, Auto correct, Online help and Wizards. 

2. Workbooks: Workbooks are the files in which worksheets related to a project are held. 

3. OLE support: Object linking and Embedding is a feature through which Excel can 

contain any object like a document, a picture etc. 

4. Maintaining high volume of data: Excel can contain large volume of data. A 

worksheet can contain 65536 rows and 256 columns. A single cell can contain a maximum of 

255 characters. One workbook can contain a maximum of 256 worksheets. 

5. Availability of functions: Several Mathematical, financial & statistical functions are 

available in an Excel package. 

6. Availability of Charts & Graphs: MS-Excel allows users to view data entered as tables 

in a graphical form as charts, which helps the user to easily understand, analyze data & 

compare data. 

7. Data Analysis Tools: MS-Excel provides a set of data analysis tools called Analysis 

Tool pack. 

8. Sorting capability: Excel has the capability of sorting any data in Ascending or 

Descending order. 

9. Auto fill feature: Excel has the feature which allows to fill cells with repetitive data such 

as chronological dates or numbers and repeated text. 
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Components of the Excel window: 

 

Rows, columns & cell: In a worksheet rows are numbered from top to bottom. The 

columns are labeled with letters from left to right. Rows are numbered from 1 to 65,536 and 

columns labelled from A to IV (256 columns). 

Title bar: The title bar contains the name of the program Microsoft Excel and the default 

name of the workbook Book1 that would change as soon as you save your file and give 

another name. 

Menu bar :The Menu bar contains menus that include all the commands you need to use 

to work your way through Excel such as File, Edit, View, Insert, Format, Tools, Data, 

Window and Help. 

Tool Bar: Tool Bars are usually shortcuts for menu items. Standard and formatting 

toolbars are displayed by default. 

Active cell: The cell in which you are currently working. 

Formula bar: displays the contents of the active cell. 

Name box: displays the cell address of the active cell. Column letter followed by the row 

number. Ex: B6 

Worksheet area: The middle portion of screen which occupies a major area is called 

worksheet area. In this area, information or data (i.e.) either textual or numerical can be 

entered and the results can be displayed. A worksheet is a large work area of 65,536 rows and 

256 columns. 
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Status bar: located at the very bottom of the screen displays brief information about 

activating features within the worksheet area. 

 Sheet tabs: appear above the status bar displaying the names of the worksheets. 

Formula bar & Name box 

The formula bar is located beneath the toolbar at the top of the Excel worksheet. Use the 

formula bar to enter and edit worksheet data. The contents of the active cell always appear in 

the formula bar. When you click the mouse in the formula bar, an X and a check mark 

appear. You can click the check icon to confirm and completes editing, or the X to abandon 

editing. 

 

Formulas: 

In Excel. One of the powerful features is formulas. A formula is an equation that is used to 

perform calculations on data in a worksheet. We can use formula to perform Mathematical, 

Statistical &date/time operations on a single value or a set of values by using operators. 

The cells in which formulas are stored, display the result of the calculation and not the 

formula. 

In Excel, a formula starts with an equal (=) sign and should be followed by the operation to 

be performed. We can use any number of operators in a single formula. MS- Excel evaluates 

the formula according to the order of precedence of the operators. 
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Examples of the formula expressions: 

1. Suppose the values in the cells B2, C2, D2 are 34, 28, 56 respectively. To add these values 

and to have the result in the cell F2, 

Step i) Click on the cell in which total marks is to be displayed, i.e F2 

ii) Type  “ = ( B2 + C2 + D2 )” 

iii) Press Enter 

The value  “118” will be displayed in F2. 

2. Suppose the value of the cell B6 is 78345. Divide the value by 5 and have it in the cell E6: 

Step i) Click the cell E6. 

ii) Type “ = (B6/5) “ 

iii) Press Enter 

The value  “15669” will be displayed in the cell E6. 

Functions : 

A function is a built-in, readymade and frequently used formula that accepts data, perform 

calculations & returns results. 

To enter a function in a cell, 

i) Click the cell in which you want the result of the function to be displayed. 

ii) Type “=” sign. 

iii) Type the function name. 

iv) Type the cell range & other arguments within brackets. 

v) Press Enter. 

Note : To specify a range of cells, a colon (:) is used between the first & last cell addresses. 

Example: =Average(B1: B10) 

Calculates the average of the values in the cells B1 to B10 

Mathematical functions with syntax and purpose: 

i) Sum( number1, number2,…) – gives the sum of the values in a specified range 

ii) Abs( number) - gives the absolute value of the number 

iii) Fact( number) - gives the factorial of the number 

iv) Sqrt(number) - gives the square root of the number 

v) Log(number) - gives the logarithm of the number 

Statistical functions with syntax and purpose: 

i) Average( range of cells) - calculates the average of the values in a specified range 

ii) Stdev(range of cells) - calculates the standard deviation of the given data 

iii) Mean( range of cells) - calculates the mean of the given data 
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iv) Max( range of cells) - gives the maximum value within the range specified 

v) count( ) - counts how many numbers are there in the list of arguments 

Statistical Analysis Tools 

Microsoft Excel provides a set of data analysis tools— called the Analysis Tool Pak— that 

you can use to save steps when you develop complex statistical or engineering analyses. You 

provide the data and parameters for each analysis; the tool uses the appropriate statistical or 

engineering macro functions and then displays the results in an output table. Some tools 

generate charts in addition to output tables. Related to worksheet functions, Excel provides 

many other statistical, financial, and engineering worksheet functions. Some of the statistical 

functions are built-in and others become available when you install the Analysis Tool Pak. 

Accessing the data analysis tools: The Analysis Tool Pak includes the tools described 

below. To access these tools, click Data Analysis on the Tools menu. If the Data Analysis 

command is not available, you need to load the Analysis Tool Pak add-in program. 

 

Analysis Tools: 

ANOVA: Single factor 

ANOVA: Two-Factor with replication 

ANOVA: Two-Factor without replication 

Correlation 

Covariance 

Descriptive statistics 

F-test two-sample for variances 

Histogram 
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Regression 

t-test: two sample assuming equal variances 

t-test: two sample assuming unequal variances 

Z-test: two sample for means 

Steps to use Analysis Tools: 

Step i) From the Menu bar choose Tools and click on Data Analysis 

ii) When the Data Analysis dialogue box appears, click on the one you want. 

iii) The corresponding dialogue box appears. Enter the Input range and Output range 

(addresses 

of the cells) 

iv) give the address of the cell where you want the result to be shown. 

iv) click OK 

v) The result will be given in the corresponding output format. 
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LECTURE 8: USE OF SPREADSHEETS FOR INTERPRETATION AND 

GRAPH CREATION 

Creating Charts : 

Charts in Excel are used to represent data pictorially. We can use different types of charts to 
represent data. 
Types of charts which are available in Excel: 
1. Column charts 
2. Bar charts 
3. Line 
4. pie 
5. XY (scatter) 
6. Area 
7. Doughnut 
8. Radar 
9. Surface 
10. Bubble 
11. Stock 
12. Cylinder, Cone & Pyramid 

Creating a Chart : 
Step i) Enter the data in a table. 
ii) Open the Insert Menu and select Chart 
iii) In the Chart Wizard – Step 1 of 4, select the type of chart you want to make and click 
Next 
iv) In the step 2 of 4, enter chart source data and click Next 
vi) In the step 3 of 4, enter the chart options like label of the chart and click Next 
vii) In the step 4 of 4, give the chart location where you want the chart to be located and press 
Finish. 
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Column Chart: Column charts are one of the most common types of graphs used to display 

data. A column chart represents data in the form of a series of vertical bars. Each bar represents a 

value. 

For example, to draw a column chart for the production of different crops in a 

region: 

 

To construct a bar chart for the above data:  

Step i) Enter the data in a table.  

ii) Open the Insert Menu and select Chart  

iii) In the Chart Wizard – Step 1 of 4, select Column chart and click Next  

iv) In the step 2 of 4, enter chart source data  

v) In the step 3 of 4, enter the chart options like label of the chart  
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vi) In the step 4 of 4, give the chart location where you want the chart to be located and press 

Finish. 

 

Pie Chart: A Pie chart is used to represent the distribution of a categorical data. In this chart, a 

circle is divided into sectors, whose area are proportional to the frequencies or percentages of 

cases under various categories. Data on each variable is entered in the Excel worksheet in a 

row or column with suitable headings. Then we select the data of the first series and choose 

pie chart and proceed as per the options given in the dialogue box. A separate chart pie chart 

should be drawn for each data set. For example, to draw a pie chart for the production of 

different crops in a region: 

For example, to draw a pie chart for the production of different crops in a region: 
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LECTURE 9: Database- concept and types, uses of DBMS/RDBMS in 

agriculture. 

  

Data:  

It is a collection of information.  

The facts that can be recorded and which have implicit meaning known as 'data'.  

Example:  

Customer -----  

1.cname.  

2.cno.  

3.ccity. 

 

Database:  

 It is a collection of interrelated data.  

 These can be stored in the form of tables.  

 A database can be of any size and varying complexity.  

 A database may be generated and manipulated manually or it may be computerized.  

 Example:  

Customer database consists the fields as cname, cno, and ccity  

Cname Cno C city 

   

  

Database System:  

It is computerized system, whose overall purpose is to maintain the information and to make that the 

information is available on demand.  

Advantages:  

1.Redundency can be reduced.  

2.Inconsistency can be avoided.  

3.Data can be shared.  

4.Standards can be enforced.  

5.Security restrictions can be applied.  

6.Integrity can be maintained.  

7.Data gathering can be possible.  

8.Requirements can be balanced 
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Database Management System (DBMS):  

 It is a collection of programs that enables user to create and maintain a database.  

 In other words it is general-purpose software that provides the users with the processes of 

defining, constructing and manipulating the database for various applications.  

 All of the organized sets of information with some kind of an indexing system which 

facilitates access to and search for specific information ( eg. indexing systems for files, 

papers/letters; table of contents in a book; the alphabetical order of arrangement of words 

in dictionary; the alphabetical order and classification system in a telephone directory; 

subject or author based classification of reference cards by individual scientists; the 

classification of books in library; the coding systems used by scientists for storing and 

retrieving samples; etc.).  

 

Definition: Database management systems (DBMS) are computerized systems for organizing, 

storing, retrieving, updating and analyzing large and related data quickly and efficiently to provide 

useful information for decision-making for specific purposes and situations. 

Disadvantages in File Processing  

 Data redundancy and inconsistency.  

 Difficult in accessing data.  

 Data isolation.  

 Data integrity.  

 Concurrent access is not possible.  

 Security Problems.  

Advantages of DBMS:  

 Data Independence.  

 Efficient Data Access.  

 Data Integrity and security.  

 Data administration.  

 Concurrent access and Crash recovery.  

 Reduced Application Development Time. 

Applications  

 Database Applications:  

 Banking: all transactions  

 Airlines: reservations, schedules  

 Universities: registration, grades  

 Sales: customers, products, purchases  
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 Online retailers: order tracking, customized recommendations  

 Manufacturing: production, inventory, orders, supply chain  

 Human resources: employee records, salaries, tax deductions. 

Relevance to agricultural research/ Uses of DBMS/RDBMS in Agriculture 

 Data are valuable resources in agricultural research.  

 They are generated at considerable expense.  

 Much of the agricultural research data is generated over several seasons through 

multidisciplinary and multilocational research, and needs to be stored and managed 

efficiently.  

 Field research, even at the individual level, involves recording data in a number of 

experimental plots or farmers’ fields and over several seasons.  

 DBMS enable such research data to be organized and managed efficiently both at the 

individual and multiuser level for purposes of analysis, decision-making and presentations..  

 Further, the users of the research data can be diverse and not limited to those who generated 

the data. Researchers like those involved in developing simulation models for decision 

support, technology transfer or in designing agricultural policy and development programmes 

often use data generated from others’ research to save on time and costs.  

 For such users, and also for individual researchers DBMS help to:  

 separate data from applications (the need to do this is becoming more and more important 

in modern research when data have to be shared between diverse users and applications)  

 avoid unnecessary duplication of data  

 perform two basic functions – reading and editing – on the data routinely and 

consistently. Both require systematic and consistent identification of the data. This can be 

difficult without a DBMS when data are large and complex  

 when data are large and complex they need to be carefully structured to identify specific 

data and eliminate redundancy and inconsistency in the databases. Database management 

systems permit this.  

Database management concepts are central to the newer tools of agricultural research like GIS (in 

natural resources management research), and bioinformatics (in plant and animal science research). 

Some example areas of agricultural research and policy where databases are useful because of the 

large variety and complexity of data are:  

 Administration and management  

 Planning and policy  

 Natural resources management  

 Managing coordinated projects  

 Genetic resources classification  

BS Publication

Telegram - https://t.me/AgroMind

https://t.me/AgroMind


Agri-Informatics Lecture Notes 
 

Prof. N. K. Kulkarni Page 55 
 

 Experimental station management  

 Bioinformatics/genomics/proteomics  

Data Representation in Database 

The most familiar way of representing data about entities (distinguishable real world objects with 

common properties; examples of entities are students, employees, states, districts, farmers, field plots, 

fertilizers, rainfall, etc.) is in the form of Tables or data files.  

Tables are two-dimensional structures consisting of columns and rows. The columns are called Fields 

and the rows are called records in database terminology. Thus, in a Table, data are stored in fields 

and records.  

A Field is the basic unit of representing information about an entity. Each field refers to one attribute 

or property of the entity. For example, ‘name’ is a field or attribute of entity employee in an employee 

table or data file;, ‘age’ is another such attribute for the same entity; temperature and rainfall are 

fields/attributes of the entity weather in a weather table or data file; plot no., dates of sowing are 

fields/attributes of the entity, experimental plot data file; district name, area, etc are data fields 

corresponding to the entity districts in a districts table or data file and so on.  

Records are actual data (text, numbers, dates, etc.) for each attribute/field in the Table. Each record is 

one set of attribute data, that is, the data of all fields for one entity (eg. text, numbers, dates, etc. 

representing say name, age, date of birth, etc. for any one employee in the employees data file, or soil 

type, texture, available water capacity etc., in soils data file, district number, name and area in a 

districts data file, etc.) 

 

 

Types of Database Management Systems 
Over the years, to satisfy the needs of data storage, processing and retrieval, database models of 

varying degrees of sophistication were devised. Large enterprises needed to build many independent 

data files containing related and even overlapping data, often in quite different formats to fulfill 
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different purposes. Data-processing activities frequently required the linking of data from several files 

necessitating designing data structures and database management systems that supported the 

automatic linkage of files. Four database models and their corresponding management programs were 

developed to support the linkage of records of these types. The following database models and their 

management systems are in common use: 

1.     Hierarchical databases. 

2.     Network databases. 

3.     Relational databases. 

4.     Object-oriented databases 

1. Hierarchical Database Management System: 

A hierarchical database is a one in which the data elements have a one-to-many relationship (1:N). 

The schema for a hierarchy has a single root. This kind of database model uses a tree-like structure 

which links a number of dissimilar elements to one primary record – the "owner" or "parent". Each 

record in a hierarchical database contains information about a group of parent child relationships. The 

data are stored as records, each of which is a collection of fields containing only one value. The 

records are connected to each other through links. The structure implies that a record can have a data 

element repeated. Hierarchical models make the most sense where the primary focus of information 

gathering is on a concrete hierarchy such as a list of business departments, assets or people that will 

all be associated with specific higher-level primary data elements. They are very simple and fast. In 

the hierarchical database model the user must have some prior information about the database. 

Hierarchical databases were popular in early database design, in the era of mainframe computers. 

The idea behind hierarchical database models is useful for a certain type of data storage, but it is not 

extremely versatile. They are confined to some very specific uses. For example, where each individual 

person in a company may report to a given department, the department can be used as a parent record 

and the individual employees will represent secondary records, each of which links back to that one 

parent record in a hierarchical structure. 

Advantage: Hierarchical 

databases relate well to anything 

that works through a one-to-

many relationship. They can be 

accessed and updated rapidly 

because in this model, the data 

structure is like that of a tree, 

and the relationships between 

records are defined in advance. 

These databases allow easy addition and deletion of records. These databases are good for hierarchies 

 

Example of a hierarchical database model 
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such as employees in an organization or an inventory of plant specimen in a museum. Data at the top 

of the hierarchy is accessed with great speed. 

Disadvantage: This type of database structure permits each child a relationship with only one parent, 

and relationships or linkages between children are not permitted, even if they make sense from a 

logical standpoint. This limitation is circumvented by a repetition of data, which adds to the size of 

the database. Searching for specific data requires the DBMS to run through the entire data from top to 

bottom until the required information is found, making queries very slow. The lower the required data 

in the hierarchy, the longer it takes to retrieve it. Adding a new field or record requires the entire 

database to be redefined. 

2. Network Database 

Management System: 

A network database model is one in 

which multiple member records or 

files are linked to multiple owner 

files and vice versa. The network 

database model can be viewed as a 

net-like form where a single element 

can point to multiple data elements 

and can itself be pointed to by 

multiple data elements. 

The network database model allows 

each record to have multiple parents as well as multiple child records, which can be visualized as a 

web-like structure of networked records. By contrast, in the hierarchical model, a data member can 

only have many child records, but only a single parent record. 

Actually, the network model is quite similar to the hierarchical model – the hierarchical model being a 

subset of the network model. However, instead of using a single-parent tree hierarchy, the network 

model uses set theory to provide a tree-like hierarchy with the exception that child tables are allowed 

to have more than one parent. It supports many-to-many relationships and can be visualized as 

a cobweb or interconnected network of records 

Advantages: A Network database is conceptually simple and easy to design. The data access is easier 

and more flexible as compared to a hierarchical model. It does not allow a member to exist without a 

parent.  The main advantage of a network database is that it can handle more complex data because of 

its many-to-many relationship. It allows for a more natural modeling of relationships between records 

or entities, as opposed to the hierarchical model. Because of its flexibility, it is easier to navigate and 

 

Example of a network database model 
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search for information in a network database. This kind of database structure isolates the management 

programs from the complex physical data storage details. 

Disadvantages: The main disadvantage is that all the records in the database need to be maintained 

using pointers, making the whole database structure very complex. The insertion, deletion and 

updating operations of any record require an adjustment of a large number of pointers. Network 

databases are difficult to use by first time users. Structural changes to the database are very difficult to 

implement. Difficulties are encountered while making alterations to the database because entering 

new data may necessitate altering the entire database. 

3. Relational Databases 

Management System: 

A relational database is one 

in which data is stored in 

the form of tables, using 

rows and columns. This 

arrangement makes it easy 

to locate and access specific 

data within the database. It 

is “relational” because the 

data within each table are 

related to each other. Tables 

may also be related to other 

tables. In relational 

databases, tables or files 

containing data are called relations (tuples), and are defined by rows (or records), and columns 

(or attributes) referred to as fields. Each table has a key field that mainly identifies each record (row), 

and on the basis of which records in different tables are related (or linked). 

This kind of a relational structure makes it possible to run queries that need to retrieve data from 

multiple tables simultaneously. An RDBMS may also provide a visual representation of the data. For 

example, it may display data in a spreadsheet-like table, allowing you to view and even edit individual 

data elements in the table. Some RDMBS programs allow you to create forms that can streamline 

entering, editing, and deleting data. Most well-known database management systems fall into the 

RDBMS category. Examples include Oracle Database, MySQL, Microsoft SQL Server, and IBM 

DB2. Some of these programs support non-relational databases, but they are primarily used for 

relational database management. 

 

Example of a relational database model 
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Currently, the relational database approach is the most popular. The older hierarchical data 

management systems are being replaced by relational database management. Relational DBMS 

software is available for large mainframe systems as well as workstations and personal computers. 

The need for more powerful and flexible data models to support scientific and business applications 

has led to extended relational data models in which table entries are no longer simple values but can 

be programs, text, unstructured data in the form of large binary, or in any other format which the end 

user needs. 

Advantages: Any data organized as tables consisting of rows and columns is much easier to 

understand. Data can be stored in separate tables or files containing logically related attributes, so that 

huge amounts of data are segmented, making management and retrieval easier and faster. Different 

tables from which information has to be linked and extracted can be easily managed. Security and 

authorization control can also be implemented more easily by moving sensitive data in a given 

database to a separate relation with its own authorization controls. Data independence is easily 

achieved in a relational database than in the more complicated tree or network structure. Redundancy 

and replication of data can be minimized. RDBMS offers the possibility of responding to queries by 

means of a language based on relational algebra and relational calculus. It offers logical database 

independence i.e. data can be viewed in different ways by the different users. Multiple users can 

access the database simultaneously which is not possible in other kinds of databases. RDBMS also 

offers better backup and recovery options. 

Disadvantages: A major constraint, and therefore disadvantage of RDBMS is its reliance on machine 

performance. If the number of tables between which relationships are to be established is large, then 

the performance in responding to the SQL queries is affected. The required hardware is complex and 

software expensive, increasing the overall cost of implementing RDBMS. 

4. Object-Oriented Database Management System: 
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A recent development in 

database technology is the 

incorporation of the object concept that has become significant in programming languages. In object-

oriented databases, all data are objects. Objects may be linked to each other by an “is-part-of” 

relationship to represent larger, composite objects. For example, the data describing a truck may be 

stored as a composite of a particular engine, chassis, gear box, steering system, etc. Classes of objects 

may form a hierarchy in which individual objects may inherit properties from objects higher up in the 

hierarchy. For example, objects of the class “motorized vehicle” will all have an engine (a truck, a car 

or an airplane). Likewise, engines are also data objects, and the engine attribute of a particular vehicle 

will be a link to a specific engine object. Multimedia databases, in which voice, music, and video are 

stored along with the traditional textual information, provide a justification for viewing data as 

objects. Such object oriented databases are becoming increasingly important, since their structure is 

most flexible and adaptable. The same is true of databases of pictures, images, photographs or maps. 

The future of database technology is generally perceived to be an integration of the relational and 

object-oriented database models. 

Advantages: Object oriented databases combine the object oriented principle with the database 

management principle to give a hybrid system that is more powerful than the conventional relational 

database management system. The principles of object orientation like consistency, isolation, 

durability, and atomicity are supported along with the principles of database systems. In OODBMS, 

working with objects in the programming language is similar to working with objects in the database. 

Each object is the database is identified by an object identifier called the OID which is generated by 

the system. The OODBMS is more powerful than the RDBMS if you are used to object oriented 

programming. Another advantage of using the OODBMS is that when your application requests for an 

object, it is sent by the database to the memory, and you work with the in-memory object. Any update 

or deletion is done to the in-memory object and these changes can later be saved to the database. This 

helps to avoid the frequent access to the database while updating, deleting, etc. 

Disadvantages: A significant disadvantage of OODBMS is that it lacks a theoretical foundation which 

makes it comparable to pre-relational systems. The use of OODBMS is relatively limited because we 

do not yet have the level of experience that we have with traditional systems. There is reluctance to 

the acceptance of this technology because OODBMSs are still very much geared towards the 

programmer, rather than the naïve end-user. While the OODBMS is limited to a small niche market, 

this problem will continue to exist. The increased functionality provided by the OODBMS makes the 

system more complex than the traditional DBMSs.  Currently, OODBMSs do not provide adequate 

security mechanisms – the database manager cannot grant access rights on individual objects or 

classes. 

Example of an object oriented database model 
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LECTURE 10: Database Design, Creation 

Database Structure/ Database Design: 

Relational databases follow well defined rules of structure to maintain data integrity. If the structure 

design is good, it allows easy modifications and data retrieval, and minimizes scope for data entry 

errors. Crucial to good design of database structure are the determination of :  

 Tables and keys  

 Relationships between the tables, and  

 Integrity rules which determine the consistency and efficiency of the database.  

Tables and Keys  

The first step in creating the database structure is to develop a list of all the data fields 

required for the database and group them into different tables by themes. The grouping 

should allow identification of the Primary and Related Tables. The tables can be related 

if they have a common field. 

 

In the above example, the two tables Table 1 (primary table) and Table 2 (related table) have a 

common field ID (Identification number of employee). Records in the two Tables can therefore 

be connected via this common field. Once connected/related, the two tables can be used to 

prepare a pay slip for an employee in any month. The pay related data for each employee are 

drawn from Table 2 and the details of the corresponding employee can be drawn from Table 1 

using the common field (ID) 
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Note that in Table 1, the identification number of each employee (ID, First column) is unique to 

distinguish one employee from another. The data in other fields need not be unique. For example, 

names of employees can be same for more than one employee and so can the other fields. Each 

row of data can be located and identified using the ID field. Each table entry contains only a 

single value. The order of the rows and columns is not important. They can be viewed or added 

in any order. The field ID. is called the Primary Key of the Table. In Table 2, records can be 

uniquely identified by a single field only when the serial number column (No., First column) is 

included in the table. So, in this table the field NO. is the primary key. The field ID in Table 2 ( 

which is the common field with Table 1) is called the Foreign Key. 

 

Relationships  

In the above example, in the primary table (Table 1), for every data value in the primary 

key field (ID) there are several values in the Related Table (Table 2) in the foreign or 

common key field (ID). The two Tables are said to have a one-to-many relationship. 
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Similarly in the districts database in the following example, DISTID is the primary key in 

the primary table and the serial number field (NO) is the primary key in the two related 

tables. DISTID is the foreign key in the related tables. The primary and the related tables 

1 and 2 are related by a one-to-many relationship. The three tables can be used to relate 

the cereals production and fertilizer use in any district and year as the field DISTID is 

common between them. 

 

Database integrity  

In a relational database, integrity must be maintained between data in the primary and related 

tables. This implies that:  

(i) There cannot be any values in the foreign key field of the related table, corresponding 

values for which do not exist in the primary table.  

(ii) Any editorial changes to the data values in the primary key field of the primary table must 

be automatically reflected in the corresponding data values in the foreign key field of 
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the related table. The user should not have to reopen each related table to make the 

required changes in the foreign key field.  

(iii) If one record is deleted from the primary table, then all the records in the related tables 

with corresponding data in the foreign key field should be deleted automatically.  

All of these essentially mean that that there must be consistency between data in the primary and 

related tables to maintain valid relationships. For such consistency the data must follow specific 

rules called data integrity rules. 

Database Integrity Rules  

(i) in all tables the primary key must be unique and that there should be no null values in this 

field. (primary key integrity)  

(ii) each non-null foreign key value in the related table must match a corresponding primary key 

value in the primary table (referential integrity)  

(iii) the data types of primary and foreign key in a the primary and related tables must match 

perfectly (domain integrity).  

Designing the database structure – summary of steps  

• Identify all relevant entities (Tables) and attributes of each entity (fields) required to produce the 

needed information  

• Group related fields into tables (one table for one theme or set of related fields)  

• Determine the relationships between the tables. (primary and related tables)  

• Determine the properties of each field (field name, data type, description, etc.)  

• Determine the primary key of each table - unique identifier for a row  

• Include a common field with the primary table in the related tables  

• Avoid data redundancy in all tables:  

 No table must have duplicate rows or columns  

 No duplication of data between tables  

 No derived or calculated data fields  

 Eliminate columns that do not depend on the primary key  

 Create new tables if necessary  

• Identify the common field between the Primary and related tables. This is usually the primary 

key in the Primary Table. The same (common) field in the related table is called the Foreign 

key  

• Ensure that the data types of the primary and foreign key are the same.  

• Connect the tables by joining the primary key from primary table with foreign key of related 

table to create relationships.  

BS Publication

Telegram - https://t.me/AgroMind

https://t.me/AgroMind


Agri-Informatics Lecture Notes 
 

Prof. N. K. Kulkarni Page 65 
 

• Add data to tables 

 Creation of Database 

MS Access is an object-oriented programme; that is everything in Access is an object, 

including the database application itself. All objects of the database are stored in a single data file, and 

the filename has an .MDB extension. The objects are managed through a Database window. An 

important feature of Access is that it comes with several database wizards. These are mini 

programmes that interact with the user about his needs for creating different objects, and then create 

the database structures that match them. The user only needs to choose among a range of options and 

enter the actual data. Excellent help are also features available in MS Access for users to learn and 

deploy the various functions. Because of such user-friendly tools for designing each object, Access is 

an appropriate database management tool for both novices and professionals.  

The first step in developing a DBMS using Access is the creation of the database file. This 

file contains all the data in the form of several tables. It also contains files for customized data entry 

forms, reports and queries that constitute the database application. Thus a database file in Access 

contains files which can be: Tables, Forms, Queries or Reports  

1. Tables are the core primary building blocks of a database. A Table is very much like 

a data table or spreadsheet containing rows (records) arranged in different columns 

(fields). At the intersection of field and a row is the individual bit of data for a 

particular record, called a cell. Each database file can have many tables. Each Table is 

collection of similar data. All the data entered into a database end up in a Table for 

storage. The specific Tables into which the data will be organized needs to be planned 

carefully and frequent changes in their form and structure should be avoided. 

Information can be entered directly into each Table, but this may prove cumbersome 

if there are too many columns and rows. In such case forms are used to enter data by 

records.  

2. Forms are a more convenient means of data entry and viewing. In Access, a fill-in-

the-blanks kind a form (similar to an application form) can be created to simplify data 

entry. Data entered in a Form gets stored in a specified row in a Table, as Access 

automatically links them. One convenient feature is that separate forms need not be 

created for filling each Table. A single form can be used to enter data into several 

Tables at the same time. It can therefore serve as link between Tables. Forms are 

designed to be used on screen for data entry based on the needs and some flexibility 

in their changes is possible, but it is better to plan them in advance.  

3. Queries are questions that users ask of the data stored in the Tables to obtain 

information. They facilitate seeing data from several Tables simultaneously. They 
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also facilitate seeing only that part of the data in the Tables that is desired at a 

particular time by filtering out the data that may not be needed.  

4. Reports are designed to be printed. They are specially formatted collections of data, 

organized in a specified way to summarize the data. A report can extract data from 

many Tables, perform simple calculations on the data and present results in a neat 

format. Reports can be created at any time. They need not always be planned 

beforehand.  

Tables, forms, reports and queries are created in separate steps, but they are related. Tables are 

the core of the DBMS, with the others having to do with entering, extracting or presenting the 

data in the Tables.  

Multiple Tables can be created in Access to reduce redundancy in a database. By creating Forms, 

Queries and Reports, data can be extracted from more than one Table easily. This can be done 

best when there is a well-defined relationship between the Tables. When two Tables have a 

common field they can be related. 

 

MS-ACCESS Data Types: 

Here are some of the most common data types you will find used in a typical Microsoft 

Access database. 

Type of Data Description Size 

Short Text 

Text or combinations of text and numbers, including 

numbers that do not require calculating (e.g. phone 

numbers). 

Up to 255 characters. 

Long Text Lengthy text or combinations of text and numbers. Up to 63, 999 characters. 

Number 
Numeric data used in mathematical calculations. 1, 2, 4, or 8 bytes (16 bytes if 

set to Replication ID). 

Date/Time Date and time values for the years 100 through 9999. 8 bytes 

Currency 

Currency values and numeric data used in 

mathematical calculations involving data with one to 

four decimal places. 

8 bytes 

AutoNumber A unique sequential (incremented by 1) number or 4 bytes (16 bytes if set to 
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random number assigned by Microsoft Access 

whenever a new record is added to a table. 

Replication ID). 

Yes/No 
Yes and No values and fields that contain only one of 

two values (Yes/No, True/False, or On/Off). 

1 bit. 
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LECTURE 11: Internet and World Wide Web (WWW),concepts, components and 

creation of Web, HTML, XML and coding. 

Internet 

• Network of interconnected computers around the world. 

• A network of computer networks which operates world-wide using a common set of 

communications protocols. 

• A computer network consisting of a worldwide network of computer networks that use the TCP/IP 

network protocols to facilitate data transmission and exchange. 

• Visualization of the various routes through a portion of the Internet 

 

What do we need to get connected to internet?/Components of Internet: 

Getting on the Internet requires: 

 Computer 

 Modem 

 Telephone Line 

 Internet Service Provider (ISP) 

 Communication Software 

 Distinguish between Modem and Telephone Line 

Modem Telephone line 

Modem is a communications device 

that allows us to communicate with 

another computer through telephone 

lines. Modem is a communications device 

that allows us to communicate with 

another computer through telephone 

lines. 

Telephone services, such as 

– ISDN, 

– 56K leased lines, and 

– T-1 connections 

Modem is abbreviation of 

modulator/demodulator. 

offer connections to the Internet at 

considerably faster connection 

speeds. 

 

 Internet Service Provider (ISP) 

• An Internet Service Provider (ISP) is a company that allow you to use their internet 

connection for a price. 

• When you register with an ISP the followings are given: 

Username : A unique name that identifies you. 

Password : A secret code that prevents other people from using your account. 
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Some Popular Internet Service Providers 

• AT&T WorldNet 

• Microsoft Network 

• America Online 

• In India: 

– VSNL (Videsh Sanchar Nigam Limited 

– MTNL (Mahanagar Telecom Nigam Limited) 

– BSNL (Bharat Sanchar Nigam Limited) 

– Satyam Online 

 Communication Software 

Computer needs communicate on software to allow you to get connected to, and interact with, the 

Internet. 

Communication software is of two types: 

– Software that Helps Establish Basic Internet Connectivity 

– Software that helps to browse, access e-mail etc. 

World Wide Web 

"The World Wide Web is the universe of network-accessible information, an embodiment of human 

knowledge." Tim Berners-Lee, a scientist at CERN (The European Organization for Nuclear Research 

(French: Organisation Européenne pour la Recherche Nucléaire), invented the World Wide Web 

(WWW) in 1989. 

• The Web was originally conceived and developed to meet the demand for automatic information 

sharing between scientists working in different universities and institutes all over the world. 

• The basic idea of the WWW was to merge the technologies of personal computers, computer 

networking and hypertext into a powerful and easy to use global information system. 

• The World Wide Web, abbreviated as WWW and commonly known as The Web, is a system of 

interlinked hypertext documents contained on the Internet. 

• With a web browser, one can view web pages that may contain text, images, videos, and other 

multimedia and navigate between them by using hyperlinks. 

 Hypertext 

• Hypertext is text displayed on a computer or other electronic device with references (hyperlinks) to 

other text that the reader can immediately access, usually by a mouse click or keypress sequence. 

• Apart from running text, hypertext may contain tables, images and other presentational devices. 

Hypertext is the underlying concept defining the structure of the World Wide Web, making it an easy-

to-use and flexible format to share information over the Internet. 
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 Web Browser 

• A web browser is a software application for retrieving, presenting, and traversing information 

resources on the World Wide Web. An information resource is identified by a Uniform Resource 

Locator (URL) and may be a web page, image, video, or other piece of content. 

• Example of Web Browser: 

Mosaic 

Internet Explorer 

Netscape Navigator 

Mozilla Firefox 

 Web Page and Websites 

• W3 contains several millions of pages of information. Each of these pages is called a Web 

Page. 

• A webpage or web page is a document or resource of information that is suitable for the 

World Wide Web and can be accessed through a web browser and displayed on a computer 

screen. 

• A web page can contain text, pictures, sound, animation and video. 

• A group of related web pages that are linked together form a Web Site. 

• The first page of a web site is called the Home Page. 

 Universal Resource Locator 

• Each web page has a unique address called Universal Resource Locator (URL). 

• Contains unique information about the server and the path on the server to find and retrieve the 

information 

Example: http://www.usd.edu/trio/tut/start/url.html 

http://  -  protocol – rules through which transmission takes place over the internet. 

www.usd.edu/ - server name - computer domain name 

trio/tut/start/  - pathname to the directory you are requesting 

url.html - filename you are requesting 

 Search Engine 

A web search engine is designed to search for information on the World Wide Web. The 

search results are usually presented in a list of results and are commonly called hits. 

Few examples of web search engines are: 

Google.com 

Ask.com 

Yahoo.com 

Bing.com 

TripleMe.com 
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Shopzilla.com 

 Web browsing 

Browse means reading superficially or at random. 

Reading information contained in the WebPages on the Internet using browsers is called web 

browsing. 

A web browser is a software application for retrieving, presenting, and traversing information 

resources on the World Wide Web. 

 

 

In the address bar of the browser enter the address of the website or enter the address of the any 

search engine. 

If the address entered is a website then the corresponding webpage will get displayed. 

In the search tab enter the information about your search. For example if you want to browse about 

computers enter the computers in the search tab. 

Then click Search tab. 

 

Components of Web:  

Web Components are a set of features that provide a standard component model for the 

Web allowing for encapsulation and interoperability of individual HTML elements. 
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Primary technologies used to create them include: 

a. Custom Elements – APIs to define new HTML elements 

b. Shadow DOM – Encapsulated DOM and styling, with composition 

c. HTML Templates, an HTML fragment is not rendered, but stored until it is instantiated via 

JavaScript 

a. Custom Elements: 

There are two parts to Custom Elements: autonomous custom elements and customized built-in 

elements. Autonomous custom elements are HTML elements that are entirely separated from 

native HTML elements; they are essentially built from the bottom up using the Custom Elements API. 

Customized built-in elements are elements that are built upon native HTML elements to reuse their 

functionality.[5] 

b. Shadow DOM: 

Shadow DOM is a functionality that allows the web browser to render DOM elements without putting 

them into the main document DOM tree. This creates a barrier between what the developer and the 

browser can reach; the developer cannot access the Shadow DOM in the same way they would with 

nested elements, while the browser can render and modify that code the same way it would with 

nested elements. The impact of CSS scoped within the Shadow DOM of a particular element is 

that HTML elements can be encapsulated without the risk of CSS styles leaking and affecting 

elements that they were not supposed to affect. Although these elements are encapsulated with regard 

to HTML and CSS, they can still fire events that can be picked up by other elements in the document.  

The scoped subtree in an element is called a shadow tree. The element the shadow tree is attached to 

is called a shadow host 

c. HTML Template 

HTML template is a way to insert chunks of HTML that are stamped at will. Scripts will not run, and 

resources that are inside a template will not be fetched until the template is stamped out. 

d. Browser Support: 

HTML Templates are supported in Google Chrome, Mozilla Firefox, Microsoft Edge, Safari, 

and Opera. 

Support for an early version of Custom Elements and Shadow DOM, known as "v0", is present in 

some Blink-based browsers like Google Chrome and Opera and is in Mozilla Firefox(requires a 

manual configuration change). The newer Custom Elements and Shadow DOM "v1" APIs are 
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implemented in Safari, Google Chrome, and Mozilla Firefox[11][12] and are in development for 

Microsoft Edge. 

Backward compatibility with older browsers is implemented using JavaScript-based polyfills. 

 

 HTML: 

 Hypertext Markup Language (HTML) is the standard markup language for documents 

designed to be displayed in a web browser. It can be assisted by technologies such 

as Cascading Style Sheets (CSS) and scripting languages such as JavaScript. 

 Web browsers receive HTML documents from a web server or from local storage 

and render the documents into multimedia web pages. HTML describes the structure of a web 

page semantically and originally included cues for the appearance of the document. 

 HTML elements are the building blocks of HTML pages. With HTML constructs, images and 

other objects such as interactive forms may be embedded into the rendered page. HTML 

provides a means to create structured documents by denoting structural semantics for text 

such as headings, paragraphs, lists, links, quotes and other items. HTML elements are 

delineated by tags, written using angle brackets. Tags such as <img />  and <input />  directly 

introduce content into the page. Other tags such as <p>  surround and provide information 

about document text and may include other tags as sub-elements. Browsers do not display the 

HTML tags, but use them to interpret the content of the page. 

 

 XML: 

 Extensible Markup Language (XML) is a markup language that defines a set of rules for 

encoding documents in a format that is both human-readable and machine-readable. 

The W3C's XML 1.0 Specification and several other related specifications—all of them 

free open standards—define XML. 

 The design goals of XML emphasize simplicity, generality, and usability across 

the Internet. It is a textual data format with strong support via Unicode for different human 

languages. Although the design of XML focuses on documents, the language is widely used 

for the representation of arbitrary data structures such as those used in web services. 
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 The Difference Between XML and HTML 

HTML XML 

HTML is an abbreviation for HyperText 

Markup Language. 
XML stands for eXtensible Markup 

Language. 

 
 

HTML was designed to display data with 

focus on how data looks. 

 

XML was designed to be a software and 

hardware independent tool used to 

transport and store data, with focus on 

what data is. HTML is a markup language itself. XML provides a framework for defining 

markup languages. 

HTML is a presentation language. XML is neither a programming language nor 

a presentation language. 

HTML is used for designing a web-page to 

be rendered on the client side. 

XML is used basically to transport data 

between the application and the database. 

HTML has its own predefined tags. While what makes XML flexible is that 

custom tags can be defined and the tags are 

invented by the author of the XML 

document. 

HTML is not strict if the user does not use 

the closing tags. 
XML makes it mandatory for the user the 

close each tag that has been used. 
HTML does not preserve white space.  

XML preserves white space. HTML is about displaying data,hence static. XML is about carrying information,hence 
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LECTURE 12: Preparation of Presentation, Import export operations 

using numerical/tabular data/text/graph/slides within different applications 

using cut-paste 

Steps in Preparing a Presentation 

Planning Your Presentation 

Preparing a presentation can be an overwhelming experience if you allow it to be one. The 

strategies and steps below are provided to help you break down what you might view as a large 

job into smaller, more manageable tasks. 

Step 1: Analyze your audience 

The first step in preparing a presentation is to learn more about the audience to whom you'll be 

speaking. It's a good idea to obtain some information on the backgrounds, values, and interests of 

your audience so that you understand what the audience members might expect from your 

presentation. 

 Step 2: Select a topic 

Next, if possible select a topic that is of interest to the audience and to you. It will be much easier to 

deliver a presentation that the audience finds relevant, and more enjoyable to research a topic that is 

of interest to you. 

 Step 3: Define the objective of the presentation 

Once you have selected a topic, write the objective of the presentation in a single concise statement. 

The objective needs to specify exactly what you want your audience to learn from your presentation. 

Base the objective and the level of the content on the amount of time you have for the presentation 

and the background knowledge of the audience. Use this statement to help keep you focused as you 

research and develop the presentation. 
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Preparing the Content of Your Presentation 

Step 4: Prepare the body of the presentation 

After defining the objective of your presentation, determine how much information you can present in 

the amount of time allowed. Also, use your knowledge about the audience to prepare a presentation 

with the right level of detail. You don't want to plan a presentation that is too basic or too advanced. 

The body of the presentation is where you present your ideas. To present your ideas convincingly, 

you will need to illustrate and support them. Strategies to help you do this include the following: 

 Present data and facts 

 Read quotes from experts 

 Relate personal experiences 

 Provide vivid descriptions 

And remember, as you plan the body of your presentation it's important to provide variety. Listeners 

may quickly become bored by lots of facts or they may tire of hearing story after story. 

 Step 5: Prepare the introduction and conclusion 

Once you've prepared the body of the presentation, decide how you will begin and end the talk. Make 

sure the introduction captures the attention of your audience and the conclusion summarizes and 

reiterates your important points. In other words, "Tell them what you're going to tell them. Tell them. 

Then, tell them what you told them." 

During the opening of your presentation, it's important to attract the audience's attention and build 

their interest. If you don't, listeners will turn their attention elsewhere and you'll have a difficult time 

getting it back. Strategies that you can use include the following: 

 Make the introduction relevant to the listeners' goals, values, and needs 

 Ask questions to stimulate thinking 

 Share a personal experience 

 Begin with a joke or humorous story 

 Project a cartoon or colorful visual 

 Make a stimulating or inspirational statement 

 Give a unique demonstration 
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During the opening you want to clearly present your topic and the purpose of your presentation. 

Clearly articulating the topic and purpose will help the listeners focus on and easily follow your main 

ideas. 

During the conclusion of your presentation, reinforce the main ideas you communicated. Remember 

that listeners won't remember your entire presentation, only the main ideas. By reinforcing and 

reviewing the main ideas, you help the audience remember them. 

Practicing and Delivering 

Step 6: Practice delivering the presentation 

Most people spend hours preparing a presentation but very little time practicing it. When you practice 

your presentation, you can reduce the number of times you utter words and phrases like, "um," "well," 

and "you know." These habits can easily diminish a speaker's credibility. You can also fine-tune your 

content to be sure you make your most important points in the time alloted. 
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LECTURE13: Smartphone Apps in agriculture for farm advises, market 

price, postharvest management etc; Geospatial technology for generating 

valuable Agri-information. 

Smartphone Apps in Agriculture: 

 Kisan Suvidha 

Kisan Suvidha is an omnibus mobile app developed to help farmers by providing relevant 

information to them quickly. With click of a button, they can get the information on weather 

of current day and next 5 days, dealers, market prices, agro advisories, plant protection, IPM 

Practices etc. Unique features like extreme weather alerts and market prices of commodity in 

nearest area and the maximum price in state as well as India have been added to empower 

farmers in the best possible manner. 

 Pusa Krishi 

ZTM&BPD Unit; ICAR-IARI, New Delhi is leading 14 ICAR institutes of North Zone-I. The 

unit strives to be a strong link between the research community and the outside world. It 

promotes Agribusiness Ventures through technology development and commercialization for 

everyone from a corporate to an individual farmer. We have a variety of technologies / 

products for commercialization. Some technologies may be market ready, however some may 

require validation and some may require up scaling. We license our technologies to both 

private and public sectors. 

 MKisan Application 

This app has been designed and developed by inhouse IT team of DAC with the help of C-

DAC Pune. It enables farmers and all other stakeholders to obtain advisories and information 

being sent by experts and government officials at different levels through mkisan portal 

without registering on the portal. 

 Shetkari Masik Android App 

“Shetkari Masik” is one of the most popular monthly magazines in the Agriculture sector, 

under publication since 1965. It is published by Department of Agriculture, Maharashtra. 

BS Publication

Telegram - https://t.me/AgroMind

https://t.me/AgroMind


Agri-Informatics Lecture Notes 
 

Prof. N. K. Kulkarni Page 80 
 

The Android app for Shetkari magazine has a very simple interface and requires mobile 

internet or Wi-Fi connectivity to register and download the issues. Once downloaded, the 

magazine can be read without internet connectivity. 

 Farm-o-pedia 

Developed by CDAC, Mumbai. The application is a multilingual Android application 

targeted for rural Gujarat. The app is useful for farmers or anyone related to agriculture. It is 

available in English and Gujarati languages. The main functionalities of the app are: 

1. Get suitable crops as per soil and season 

2. Get crop wise information 

3. Check weather in your area 

4. Manage your cattle 

 Bhuvan Hailstorm App 

A mobile app has been developed to capture crop loss happened due to hailstorm. Agriculture 

Officer will go to the field with mobile or tablet loaded with this mobile app. This mobile app 

is able to capture following parameters : 

1. Photograph of field with latitude and longitude. 

2. Name of Crop 

3. Date of sowing 

4. Date of likely harvesting 

5. Source of irrigation 

This captured data will automatically be plotted to Bhuvan Portal and analysis can be done 

easily. 

 Crop Insurance mobile app 

Crop Insurance mobile app can be used to calculate the Insurance Premium for notified crops 

based on area, coverage amount and loan amount in case of loanee farmer. It can also be used 

to get details of normal sum insured, extended sum insured, premium details and subsidy 

information of any notified crop in any notified area. 
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 AgriMarket 

AgriMarket mobile app can be used to get the market price of crops in the markets within 50 

km of the device’s location. This app automatically captures the location of person using 

mobile GPS and fetches the market price of crops in those markets which falls within the 

range of 50 km. There is another option to get price of any market and any crop in case 

person does not want to use GPS location. 

 Digital Mandi India 

This App helps in checking the latest Indian agricultural commodities Mandi prices from 

different states and districts. Easy to use and intuitive, the app enables farmers, traders and all 

others to know the updated Mandi price from anywhere. Its main features are: 

o Browse through various commodity categories 

o Browse prices in different states 

o Simplified flow to reach the selected commodity's mandi price 

o Copy the mandi price of a commodity 

o Sync data from the Indian government portal Agmarknet.nic.in 

 MNCFC 

This Android based application, developed by National Remote Sensing Centre, ISRO, is 

useful for field data collection for crop assessment using satellite data under FASAL project 

of Ministry of Agriculture. The application can be used for collecting Field Photographs 

(640x480 resolution), GPS coordinates and Field information, such as crop type, condition, 

sowing date, soil type, etc.The farmers can also upload pictures taken through their mobile 

devices depicting status of the crops, varieties and soil as crowd sourcing. This information 

will be extermely useful in creating a national geospatial database of crops. The information 

can be sent in real-time, or later on using the Send Later option. All data received though this 

application reaches at ISRO’s Bhuvan Server. 

 Crop Info 

Developed by Nirantara Livelihood Resources Private Limited, Bangalore, Karnataka. The 

Crop Info App provides Production Technology of commercially important Horticultural & 

Agricultural crops on your smartphone. It provides production aspects, post-harvest 
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technology, processing possibilities and market information. Crop Info is an App specifically 

developed for students & faculty of Agricultural & Horticultural Universities, Subject Matter 

Specialists & Extension Officials of Agriculture & Horticultural Departments, Private Sector 

Professionals, Farmers and anyone interested in cultivation of crops. 

 

 Precision Agriculture: 

 Precision agriculture, or precision farming, is a farming concept that utilizes 

geographical information to determine field variability to ensure optimal use of inputs 

and maximize the output from a farm.  

 Precision agriculture gained popularity after the realization that diverse fields of land 

hold different properties.  

 Large tracts of land usually have spatial variations of soils types, moisture content, 

nutrient availability and so on.  

 Therefore, with the use of remote sensing, geographical information systems (GIS) 

and global positioning systems (GPS), farmers can more precisely determine what 

inputs to put exactly where and with what quantities.  

 This information helps farmers to effectively use expensive resources such as 

fertilizers, pesticides and herbicides, and more efficiently use water resources.  

 In the end, farmers who use this method not only maximize on their yields but also 

reduce their operating expenses, thus increasing their profits.  

 

 Geospatial Data Collection, Analysis, and Interpretation for 

Agricultural Purposes: 

 Geospatial Technnology: 

Geospatial technology refers to equipment used to measure and analyze Earth's land and 

features. Systems such as Global Positioning System (GPS) and Geographical Information 

System (GIS) are used in geospatial work. 

The most common GTs are:  

o Remote sensing: imagery and data collected from space- or airborne camera and sensor 

platforms (satellites, aerial, UAVs, terrestrial sensor). Some commercial satellite image 

providers now offer images showing details of one-meter or smaller.  
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o The Geographic Positioning System (GPS): a network of U.S. Department of Defense 

satellites which can give precise coordinate locations to civilian and military users with 

proper receiving equipment (note: a similar European system called Galileo will be 

operational within the next several years while a Russian system is functioning but restricted).  

o The Geographic Information System (GIS): is a system designed to capture, analyse store, 

manage and present all types of spatial or geographical data. GIS use the space and time 

dimensions as the key index variable for all other information. 

 

 Approaches to Agriculture using Geo Spatial Technologies/Applications of 

Geospatial Technology  

a. Climate Smart Agriculture  

b. Precision Agriculture  

c. Conservation Agriculture 

a. Novel Technologies for Climate-Smart Agriculture 

 Space-Technology derived applications developed at NASA  

 MicroRadiometer for Climate-Smart Applications to reveal Climate Change in shallow waters 

close to land and in deep waters.  

 Sensors Enable Plants to Text Message to Farmers to improve the nutrition, safety, and 

durability of food on Earth.  
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 Photo-catalytic Solutions Create Self-Clearing Surfaces : A materials technology developed 

has future promising application, not only to keep surfaces clean, but potentially germ free.  

 Other Technologies  

 Climate Smart Agriculture Mechanization Using Robotics-Driverless tractors, Portal crop 

scouting platform, weed mapping, weeding, micro spraying, irrigation, and selective 

harvesting etc  

 Drones for Climate-Smart Agriculture 

 

b. How Geo-Spatial Technologies can help Precision Agriculture?: 

o Precision agriculture (PA) is an approach to farm management that uses information 

technology (IT) to ensure that the crops and soil receive exactly what they need for optimum 

health and productivity. The approach is also known as satellite agriculture, as-needed 

farming and site-specific crop management (SSCM)  

o Precision farming techniques are employed to increase yield, reduce production costs, and 

minimize negative impacts to the environment. 

o Site-specific data ( e.g. soil characteristics, fertility and nutrient data, topographic and 

drainage characteristics, yield data, harvester-mounted yield sensor data, and remotely-sensed 

vegetation indices) are collected from different sources and stored and managed in a spatial 

database 

1. Soil types 

2. pH rates 

3. Pest infestation 

4. Nutrient availability 

5. Soil moisture content 

6. Fertility requirements 

7. Weather predictions 

8. Crop characteristics 

9. Hybrid responses 

c. Site-Specific Crop Management  

o GIS-GPS-RS technologies are used in combination for precision farming/site-specific crop 

management.  

o GIS analytical capabilities measures variable parameters that can affect agricultural 

production include – Yield variability & Crop variability (e.g., density, height, nutrient & 

water stress, chlorophyll content) – Physical parameters of the field & Soil chemical and 
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physical properties – Anomalous factors (e.g., weed, insect, and disease infestation, wind 

damage) – Variations in management practices (e.g., tillage practices, crop seeding rate, 

fertilizer and pesticide application, irrigation patterns and frequency) 
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Lecture 14: Decision Support Systems, concepts, components and 

applications in Agriculture, Agriculture Expert system, Soil Information 

System etc, for supporting farm decisions. 

 Decision Support Systems: 

Decision making is a major component of living and, therefore, a fascinating topic for discussion and 

investigation. Several fields in science also occupy themselves with the nature of different aspects of decision 

making: philosophy, psychology, sociology, economics, etc. In most institutional decision-making problems, 

there are three main aspects of concern: 

 The information about the current situation and, possibly, about the past.  

 The processes that are to be influenced by the decisions.  

 The actual decision-making process.  

For instance, decision making concerning acid rain illustrates the above three aspects clearly, as follows:  

 The information consists of huge amounts of data regarding industrial, agri-cultural, and automotive 

activities. It also consists of data about wind and sun activities and about the types of power stations 

used.  

 The processes to be influenced by the decisions consist of the production and emission of polluting 

material, together with the atmospheric transformation (chemical reactions and transportation) and the 

deposition process. Therefore the processes are basically of a physical and economic nature.  

 The decision-making process consists of several interacting subprocesses at the local, national, and 

international levels.  

 Definition: 

DSS deal with semi-structured and some unstructured problems. With the ever-increasing advances in 

computer technology, new ways and means of computer-assisted decision-making was born. As a 

result hereof, over the passage of time, different DSS definitions arose: 

• DSS is a model-based set of procedures for processing data and judgments to assist a manager in his decision 

making. 

• “Decision Support Systems couple the intellectual resources of individuals with the capabilities of the 

computer to improve the quality of decisions. It is a computer-based support system for management decision 

makers who deal with semi-structured problems.  

 

• A decision support system is an interactive system that provides the user with easy access to decision models 

and data in order to support semi-structured and unstructured decision-making tasks.  
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• DSS is a computer-based information system consisting of hardware/software and the human element designed 

to assist any deci sion-maker at any level. However, the emphasis is on semi-structured and unstructured tasks. 

• DSS is a computer-based systems that help decision makers confront ill-structured problems through direct 

interaction with data and analysis models.  

• DSS are computer-based systems that bring together information from a variety of sources, assist in the 

organisation and analysis of information and facilitate the evaluation of assumptions underlying the use of 

specific models.  

• DSS is a computer-based information system that combines models and data in an attempt to solve semi-

structured and some unstructured problems with extensive user involvement. 

 

 Components of DSS: 

A decision support systems consists of three main components, namely database, software system and 

user interface.. 

1. DSS Database: It contains data from various sources, including internal data from the 

organization, the data generated by different applications, and the external data mined form 

the Internet, etc. The decision support systems database can be a small database or a 

standalone system or a huge data warehouse supporting the information needs of an 

organization. To avoid the interference of decision support system with the working of 

operational systems, the DSS database usually contains a copy of the production database. 

2. DSS Software System: It consists of various mathematical and analytical models that are 

used to analyze the complex data, thereby producing the required information. A model 

predicts the output in the basis of different inputs or different conditions, or finds out the 

combination of conditions and input that is required to produce the desired output. 

A decision support system may compromise different models where each model performs a 

specific function. The selection of models that must be included in a decision support system 

family depends on user requirements and the purposes of DSS. Note that the DSS software 

contains the predefined models (or routines) using which new models can be built to support 

specific type of decisions. 
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Figure 1. DSS Architecture 

3. DSS User Interface: It is an interactive graphical interface which makes the interaction 

easier between the DSS and its users. It displays the results (output) of the analysis in various 

forms, such as text, table, charts or graphics. The user can select the appropriate option to 

view the output according to his requirement. 

 

 Applications of DSS in Agriculture: 

1. DSS in crop productivity improvement 

o DSS is widely applied in various parts of India for different agricultural management 

activities. Crop productivity being one such activity, it has given considerably good 

results with the use of DSS.  

o The DSS named as “Crop Environment Resource Synthesis (CERES) -Wheat”, is a 

part of DSSAT which was successfully applied to simulate the crop growth and 

development of wheat under variable climatic, water and nitrogen levels in semi-arid and 
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subtropical regions of Punjab for five cropping seasons from 2000-2001 through 2004- 

2005. 

o The model results concluded that grain yield and water productivity are affected by water 

holding capacity of the soils. This model was then extended with Cropping System Model 

(CSM) named as “DSSAT-CSMCERES-Wheat 4.0” 

o Cropping System Simulation Model (CropSyst) is another simulation based DSS 

model linked with Geographical Information System (GIS).  

o It uses the identical approach to simulate the growth and development of all herbaceous 

crops using periodic biomass and Leaf Area Index (LAI).  

o It helped to decide water saving and water productivity policy for rice crop in Punjab by 

integrating crop management practices such as transplanting date, type of seed and 

irrigation. 

o Indian Agriculture Research Institute (IARI) then evaluated CropSyst and CERES 

models, and results of evaluation demonstrated that these models can be effectively 

applied for on farm management activities such as irrigation and soil nitrogen 

management. 

2. DSS in crop water requirements management 

o DSS is also applied to careful management of water resources, crop water 

requirements.  

o Crop water requirements depend on the factors such as evaporation, 

evapotranspiration, meteorological factors such as solar radiation, air temperature, 

humidity, wind speed etc. 

o CROPWAT DSS helped to decide irrigation scheduling for different crop patterns 

and to calculate crop water requirements in eastern Godavari Delta, Andra Pradesh. 

Along with climatic data it helped in assessment of reference evapotranspiration 

under temperature conditions of Kashmir Valley.  

o It also gave good results when applied to simulate different crop water requirements 

as per the need of crop under different planting dates and probable canal water 

supplies for Noorpur distributary of Western Yamuna Canal system, West Bengal.  

o Along with the DSSAT DSSAT-Cropping System Model(CSM) DSSAT- 

CROPGRO(Crop Growth Model) DSSAT-Root Zone Water Quality 

Management (RZWQM) DSSAT-P : (For Soil and Plant Phosphrous Management) 

GIS mapping model it was used to spatially analyze and study crop water 

requirements of rice in the eastern part of India. It also helped to study the spatial 

variation of climatic water balance, probabilistic monthly monsoon rainfall and 

mapping of cold periods in the region 
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3. DSS in irrigation scheduling 

o Irrigation scheduling is one of the important activities in agriculture. A DSS tool for 

Simulation of WAter and SALT (SWASALT) was calibrated and validated for 

irrigated areas in the semi - arid region of Haryana. It helped to prevent on farm water 

logging and soil salinization because of canal irrigation.  

o This model was also used to calculate Water Management Response Indicators 

(WMRI) which helped to optimize the on farm irrigation schedule by minimizing the 

percolation losses to ground water for different soil types.  

o GIS based integrated model of rainfall, soil, water use, canal flow model, soil water 

balance model and groundwater flow model is used as an effective DSS tool. It 

helped to increase crop production for different cropping pattern as per the 

groundwater availability for Godavari Delta Central Canal Irrigation Project in Andra 

Pradesh. 

4. DSS based on climatic data 

o Climatic parameters such as temperature, rainfall, sunshine hours play a very 

important role in crop production. DSSAT Cropping System Model (DSSAT-CSM) 

was also applied to study impact of climatic parameters in rice-wheat system 

productivity over the Indo-Gangetic plains of India.  

o The comparison of observed and simulated rice and wheat yield showed that, along 

with climatic parameters crop productivity can be improved by integrating 

biotechnological advancements and precision farming.  

o A simulation based multi-year, multi-crop and daily time step cropping based model 

called as “Crop Production and Management (CROPMAN)” model was used in 

Punjab to study the effects of different dates of transplanting and weather parameters 

on yield, evapotranspiration and water productivity. The analysis showed that rice 

yield in Punjab can be increased by shifting of transplanting from mid May to lower 

June onwards 

5. DSS in advisory system 

o Advisory DSS is playing extremely important role in Indian agriculture. e-Sagu, farm 

specific DSS developed by IIIT, Hyderabad, and Media Lab Asia under the aegis of 

Media Lab Asia which helped to improve farm productivity by delivering high-

quality farm specific agro-expert decisions in a timely manner to each farm at the 

farmer’s doorsteps.  
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o The advice was provided at all stages of cultivation of crops from sowing to 

harvesting, which reduces the cost of cultivation and increases farm productivity as 

well as quality of Agricultural commodities. 

o “mKRISHITM” DSS tool developed by Tata Consultancy Services and was 

deployed in Borgaon village, Maharashtra, for proper nutrient and pest management 

advice for grape farms through mobile phones.  

o Integrated Pest Management is an important parameter in agriculture. An Integrated 

Pest Management (IPM) DSS called as “Cell Phone” was developed for sustainable 

plant protection of south 24 paraganas, West Bengal. The DSS helped for sustainable 

IPM by creating continuous awareness among farmers and in turn to improve crop 

productivity. 

 Expert Systems in Agriculture 

Initially, computer scientists were interested in capturing non-quantitative decision making 

models in a computer, and they used expert systems to generate those models. What were some basic 

assumptions about human reasoning that drove expert systems? Perhaps the initial primary 

assumptions were: 

 Experts know more than non experts.  

 People use information and knowledge based on their past experience.  

 People use heuristics.  

 People use specific, a priori rules to solve problems.  

 People use focused knowledge to solve problems.  

 

Structural Nature of Expert Systems  

Because it was assumed that human problem solvers used rules and knowledge could be captured as 

rules, rule bases and their processing were the critical component of expert systems (Figure 12.1). 

Accordingly, the structure of a classic expert system was designed to meet those needs. Ultimately, 

expert systems were composed of six components:  

a. data/database 

b. user interface 

c. user 

d. knowledge base/rule base and  

e. An inference engine to facilitate analysis of that knowledge base. 
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f. An expert system software. 

 

a. Data  

The data used by the system could include computer-generated data, data gathered from a database, and data 

gathered from the user. For example, computer-generated data might derive from an analysis of financial 

statement data as part of a program to analyze the financial position of a company. Additional data might be 

selectively gathered straight from an integrated database. Further, the user might be required to generate some 

assessment or provide some required data. Typically, initial expert systems required that the user provide key 

inputs to the system.  

b. User Interface  

Since the user typically interacted with the system and provided it with data, the user interface was critical. 

However, an expert system user interface could take many forms. Typically, there would be a question from the 

system, and the user would select one or more answers from a list, as in a multiple choice test. From there, the 

system would go to another question, and ultimately provide a recommended solution. In some cases, the user 

would need to analyze a picture or a movie clip in order to answer the questions.  

c. User  

In any case, in a classic expert system, the user is a key component to the system, since it is the user who 

ultimately provides environmental assessments, generates inputs for the system and as a result, disambiguates 

the questions provided by the system to gather data from the user. Research has found that different user groups, 

e.g., novice or expert, given the same interrogation by the system, would provide different answers. As a result, 

generating that user interface and building the system for a particular type of user are critical 

d. Knowledge Base/Rule Base  

The knowledge base typically consisted of a static set of ―if…then…ۅ rules that was used to solve the problem. 

Rules periodically could be added or removed. However, the knowledge needed for solving the particular 

problem could be summarized, and isolated. In addition, the very knowledge that was used to solve an inquiry 

also could be used to help explain why a particular decision was made. (Some researchers also include 

explanation facility as its own component.) Accordingly, gathering, explaining, and verifying and validating that 

knowledge is the focus of most of the rest of this discussion in this paper. 
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e. Inference Engines  

Inference engines facilitate use of the rule-base. Given the necessary information as to the existing conditions 

provided by the user, inference engines allow processing of a set of rules to arrive at a conclusion by reasoning 

through the rule base. For example with the system ―if a then b, and ―if b then c would allow us to ―reason 

that a led to b and then to c. As rule-based systems became the norm, the inference engine saved each developer 

from doing the same thing, and allowed developers to focus on generation of the knowledge base. Developers 

became referred to as knowledge engineers. Ultimately, data was gathered, combined and processed with the 

appropriate knowledge to infer the matching solution. 

f. Expert System Software  

Because the expert system components were distinct, software could be designed to facilitate the ability of 

developers to focus on problem solution, rather than building the components themselves. As a result, a wide 

range of so-called ―expert system shellsۅ were generated, for example, EMYCIN, ART (Automated Reasoning 

Tool by Inference Corporation). 

 Definition of Expert Systems:  

Accordingly, over the years there have been a number of definitions of expert systems, including the following:  

 A program that uses available information, heuristics, and inference to suggest solutions to problems in 

a particular discipline. 

 The term expert systems refer to computer programs that apply substantial knowledge of specific areas 

of expertise to the problem solving process. 

 The term expert system originally implied a computer-based consultation system using AI techniques 

to emulate the decision-making behavior of an expert in a specialized, knowledge-intensive field. 

 

As a result, we will call a system an expert system when it has the following characteristics:  

o A rule-based approach is used to model decision making knowledge, and that those rules may include 

some kind of factor, to capture uncertainty.  

o Interacts with a user from whom it gathers environmental assessments, through an interactive 

consultation (not always present).  

o Designed to help facilitate solution of a particular task, typically narrow in scope.  

o Generally performs at the level of an informed analyst.  

 

 Soil Information System: 

Soil Information System (SIS) is an industry leading soil mapping technology that uses 

advanced sensors and intelligent targeting and geo-processing algorithms to produce high resolution, 

accurate soil and topographic information.   By providing a greater understanding of the physical and 
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chemical characterization of the soil, including how inputs move through the soil, SIS enables 

farmers’ trusted advisors to implement more effective solutions to resolve the unique challenges of 

each area of their fields.   This information can be used to make critical farm management decisions 

with irrigation, drainage, fertility, and more. 

Key Features 

 Assess detailed soil properties for each field such as soil texture, compaction, root zone depth, 

moisture retention and availability, and soil fertility 

 View soil analysis for the top 48 inches (122 cm) of the field’s surface in 3D 

 Download soil maps into your farm management software application, including Trimble Ag 

Software or other third-party software systems 

 Create variable rate application maps from the soil information to help maximize plant growth 

 

Types of Maps 

SIS offers precise 3D soil models for dozens of soil physical and chemical characteristics including: 

 Root zone depth 

 Soil texture (clay, sand, coarse fragment content) 

 Moisture holding capacity 

 Compaction characteristics 

 Macro and micro-nutrient levels 

 Salt and toxicity concentrations 

 

Applications: 

1. Pre-Purchase Land Evaluation 

SIS makes it possible to obtain a complete picture of the land you are considering before purchase or 

development. With a SIS analysis you will be able to predict a field’s potential for growing capacity 

and identify challenges that will come up in the course of layout and planting. SIS helps growers 

avoid the pitfalls associated with sub-optimal soil properties that can permanently limit crop quality 

and yield. 

2. Field Preparation and Field Design 

The single greatest opportunity a grower has to influence the long-term output of any field, vineyard, 

or orchard comes with the design and planting of a new field. Utilizing the SIS ensures that growers 

are able to design and prepare fields that are optimized for the long-term. SIS makes it possible to 

know precisely where to add deep-root amendments, select and plant crop varieties based on known 

moisture holding characteristics, and minimize in-field variability. 
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3. Improve Crop Quality 

SIS gives growers the tools they need to optimize growing conditions and improve overall crop 

quality. Plant materials within a field may be uniform, but the soils in which those crops grow are not. 

With SIS, growers can assess the variability within a field and treat different zones according to their 

unique needs, thereby raising quality to the highest grade achievable throughout the field. 

4. Increase Output from Sub-par Field Areas 

Despite best efforts, sub-par field areas can vex even the most committed grower. SIS can eliminate 

the guesswork and experimentation that goes into "fixing" these areas by revealing the exact factors 

that are limiting yield. Understand what keeps these areas from meeting production standards and 

design a strategy to bring all field areas to maximum growing capacity. 

5. Optimize the Use of Water, Fertilizer, and Amendments 

Growers can immediately improve their bottom line by employing more efficient watering, fertilizer, 

and amendment application strategies. The difficulty comes with knowing where and to what degree 

you can reduce inputs without compromising crop quality. SIS makes it possible to target applications 

– making sure expensive inputs are used efficiently. Growers using SIS data no longer need to 

manage to the lowest common denominator, instead they can take advantage of naturally occurring 

availability while concentrating on helping low-productivity areas achieve higher yield and quality. 

Advantages: 

 Making critical soil and farm management decisions with irrigation, drainage, fertility and 

amendment applications 

 Saving time and operating costs by using soil variability to target precise sampling locations, 

sometimes reducing the number of samples taken by 60% over traditional sampling methods 

 Improving input application by showing where they need to be applied to maximize plant growth 

 Making better soil management decisions with irrigation, drainage, and fertility data 

 Maximizing plant growth using soil information from variable rate application maps 
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Lecture 15: Communication Process, Berlo’s Model, Feedback and 

barriers to communication. 

Introduction to Communication: 

Communication is a learned skill. However, while most people are born with the physical ability to 

talk, not all can communicate well unless they make special efforts to develop and refine this skill 

further.  

Very often, we take the ease with which we communicate with each other for granted, so much so that 

we sometimes forget how complex the communication process actually is. 

Definition: 

Communication is the process of exchanging information, thought, ideas, and feelings from one 

individual to another. Communication is a two way process by which a message is passed from the 

sender to the receiver with the objective that message sent is received and understood as intended. 

The Basic Elements of Communication process 

1. The Sender: The communication process begins when a person, known as the sender, 

generates a message. Messages stem from a person’s need to relate to others, to create 

meanings, and to understand various situations 

2. The Message: The message is a stimulus produced by a sender and responded to by a 

receiver. Messages may be verbal, nonverbal, written materials, and artistic.  

3. The Channel: The channel is the medium through which a message is transmitted. There are 

three major communication channels: visual, auditory, and kinesthetic. The visual channel 

consists of sight and observation. The auditory channel consists of spoken words and cues. 

The kinesthetic channel refers to experiencing sensations. 

4. The Receiver: The receiver is the person who intercepts the sender’s message. Receiving is 

influenced by complex physiological, psychological, and cognitive processes. The 

physiological component involves the process of hearing.  

5.  Feedback: Feedback is the information the sender receives about the receiver’s reaction to 

the message. The function of feedback is to provide the sender with information about the 

receiver’s perception of a situation. Having this information, the sender can then adjust the 

delivery of the message to communicate more effectively. 
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 Berlo’s Communication Model: 

The Berlo’s model of communication takes into account the emotional aspect of the message. Berlo’s 

model of communication operates on the SMCR model. 

In the SMCR model 

 S - Source 

 M - Message 

 C - Channel 

 R - Receiver 

 

 

 

S - Source 

The source in other words also called the sender is the one from whom the thought originates. He is 

the one who transfers the information to the receiver after carefully putting his thoughts into words. 

How does the source or the sender transfer his information to the recipient ? 

It is done with the help of communication skills, Attitude, Knowledge, Social System and Culture. 

 Communication Skills 

An individual must possess excellent communication skills to make his communication 

effective and create an impact among the listeners. The speaker must know where to take 

pauses, where to repeat the sentences, how to speak a particular sentence, how to pronounce a 

word and so on. The speaker must not go on and on. He should also make a point to cross 
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check with the recipients and listen to their queries as well. An individual must take care of 

his accent while communicating. A bad accent leads to a boring conversation. 

 Attitude 

It is rightly said that if one has the right attitude, the whole world is at his feet. There is 

actually no stopping for the person if he has the right attitude. A person might be a very good 

speaker but if he doesn’t have the right attitude, he would never emerge as a winner. The 

sender must have the right attitude to create a long lasting impression on the listeners. An 

individual must be an MBA from a reputed institute, but he would be lost in the crowd 

without the right attitude. 

 Knowledge 

Here knowledge is not related to the educational qualification of the speaker or the number of 

degrees he has in his portfolio. Knowledge is actually the clarity of the information which the 

speaker wants to convey to the second party. One must be thorough in what he is speaking 

with complete in-depth knowledge of the subject. Remember questions can pop up anytime 

and you have to be ready with your answers. You need to be totally familiar with what you 

are speaking. Before delivering any speech, read as much you can and prepare the subject 

completely without ignoring even the smallest detail. 

 Social System 

Imagine a politician delivering a speech where he proposes to construct a temple in a Muslim 

dominated area. What would be the reaction of the listeners ? They would obviously be not 

interested. Was there any problem in the communication skills of the leader or he didn’t have 

the right attitude ? The displeasure of the listeners was simply because the speaker ignored the 

social set up of the place where he was communicating. He forgot the sentiments, cultural 

beliefs, religious feelings of the second party. Had it been a Hindu dominated society, his 

speech would have been very impressive. 

 Culture 

Culture refers to the cultural background of the community or the listeners where the speaker 

is communicating or delivering his speech. 
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M - Message 

When an individual converts his thoughts into words, a message is created. The process is also called as 

Encoding. 

Any message further comprises of the following elements: 

 Content 

One cannot show his grey matter to others to let him know what he is thinking. A thought has 

to be put into words and content has to be prepared. Content is actually the matter or the script 

of the conversation. It is in simpler words, the backbone of any communication. 

Ted to Jenny -“I am really exhausted today, let’s plan for the movie tomorrow evening”. 

Whatever Ted has communicated with Jenny is actually the content of the message. It is very 

important for the speaker to carefully choose the words and take good care of the content of 

the speech. The content has to be sensible, accurate, crisp, related to the thought to hit the 

listeners bang on and create an immediate impact. 

 Element 

It has been observed that speech alone cannot bring a difference in the communication. Keep 

on constantly speaking and the listeners will definitely lose interest after some time. The 

speech must be coupled with lots of hand movements, gestures, postures, facial expressions, 

body movements to capture the attention of the listeners and make the speech impressive. 

Hand movements, gestures, postures, facial expressions, body movements, gestures all come 

under the elements of the message. 

 Treatment 

Treatment is actually the way one treats his message and is conveys to the listeners. One must 

understand the importance of the message and must know how to handle it. If a boss wants to 

fire any of his employees, he has to be authoritative and can’t express his message in a casual 

way. This is referred to as the treatment of the message. One must understand how to present 

his message so that the message is conveyed in the most accurate form. 
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 Structure 

A message cannot be expressed in one go. It has to be properly structured in order to convey 

the message in the most desired form. 

 Code 

Enter a wrong code and the locks will never open. Enter a wrong password, you will not be 

able to open your email account. In the same way the code has to be correct in the 

communication. Your body movements, your language, your expressions, your gestures are 

actually the codes of the message and have to be accurate otherwise the message gets 

distorted and the recipient will never be able to decode the correct information. 

C - Channel 

Channel - Channel actually refers to the medium how the information flows from the sender to the 

receiver. 

How does one know what the other person is speaking ? - Through Hearing. 

How does one know whether the pasta he has ordered is made in white sauce or not ? - 

Through Tasting. 

How does one know that there is a diversion ahead or it’s a no parking zone? - Through Seeing. 

How will an individual come to know that the food is fresh or stale ? How do we find out the 

fragrance of a perfume ? - Through Smelling. 

How will you find out whether the milk is hot or not ? - Through Touching. 

All the five senses are the channels which help human beings to communicate with each other. 

R - Receiver 

When the message reaches the receiver, he tries to understand what the listener actually wants to 

convey and then responds accordingly. This is also called as decoding. 

The receiver should be on the same platform as the speaker for smooth flow of information and better 

understanding of the message. He should possess good communication skills to understand what the 

speaker is trying to convey. He should have the right attitude to understand the message in a positive 
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way. His knowledge should also be at par with the listener and must know about the subject. He 

should also be from the same social and cultural background just like the speaker. 

There are several loopholes in the Berlo’s model of communication. According to the berlo’s model 

of communication, the speaker and the listener must be on a common ground for smooth conversion 

which is sometimes not practical in the real scenario. 

Criticism of Berlo’s smcr model of communication: 

1. No feedback / don’t know about the effect 

2. Does not mention barriers to communication 

3. No room for noise 

4. Complex model 

5. It is a linear model of communication 

6. Needs people to be on same level for communication to occur but not true in real life 

7. Main drawback of the model is that the model omits the usage of sixth sense as a channel which 

is actually a gift to the human beings (thinking, understanding, analyzing etc). 

 

 Role of Feedback in Communication Process: 

Communication is the exchange and flow of information and ideas from one person to another. It 

involves a sender transmitting an idea, information, or feeling to a receiver. Effective communication 

occurs only if the receiver understands the exact information or idea that the sender intended to 

transmit. 

The communication has a vicious cycle which continues even after sending message to the 

respondents. The audience or the respondents may or get the same intended message as the speaker 

intends to send. This cycle ends only when they share their understandings and comments to the 

speaker about what they have understood. This process is called feedback. 

1. It completes the whole process of communication and makes it continuous. 

2. It sustains communication process 

3. It makes one know if one is really communication or making sense 

4. It is a basis for measuring the effectiveness of communication 

5. It is a good basis for planning on what next to be done especially statistical report 

6. Communication will be useless without feedback 
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7. Feedback paves way for new idea generation 

 Barriers to Communication: 

1. P h y s i  c a l   B a r r  i e r s 

Open plan building designs are attractive as they allow colleagues to communicate quickly and 

efficiently. The moment you shut the door to your office, create distance between people or erect 

walls that divide your staff, you are creating physical barriers to effective communication. Sometimes 

these obstacles are unavoidable, such as companies that have offices in different locations, but there 

are solutions such as video technology and other advancements that can alleviate these hurdles. 

2. P e r c e p t u a l   B a r r i e r s 

While physical barriers are easy to see, perceptual barriers are those you erect in your mind. The way 

you communicate could be affected by preconceived ideas, your typical behaviour patterns or 

misunderstood body language. You must keep an open mind when talking, be interested in the 

conversation, and clearly articulate your message so any negative assumptions made about you by 

others will fade away. 

3. E m o t i o n a l   B a r r i e r s 

Self-confidence plays an enormous role in breaking down psychological barriers. By having an in-

depth understanding of the information you’re sharing with others, you will be able to deliver it with 

clarity. This knowledge increases the probability that those receiving the information will understand 

it and be able to act on it. However, sometimes our emotions take over when communicating with 

others, and feelings such as anger, pride and anxiety can cloud our judgment and prevent 

great communication. Emotional intelligence is an incredibly important skill to learn if you want to be 

seen as a leader within your organisation, and being able to keep your emotions, and the emotions of 

those around you in check will lead to a more highly efficient team. 

4. C u l t u r a l   B a r r i e r s 

Modern business is conducted in a global community, whether it's the mix of staff in the workplace, 

or working with colleagues, suppliers, and retailers in other parts of the world. By understanding 

cultural sensitivities of any business stakeholder, and respecting their values and beliefs, cultural 

barriers can be removed from the process. Respect is the key, at times, you will have to adapt to 

others while other occasions people joining your organisation will have to adjust. By identifying 

cultural differences and developing strategies to accommodate them, you are far more likely to enjoy 

more exceptional communication in your business. 
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5. L a n g u a g e  B a r r i e r s 

Communicating with people whose native language is not English can pose problems. However, it’s 

not the only language issue businesses face. The way people speak is different from each generation, 

speech impediments can cause comprehension issues, and industry specific language may be difficult 

to understand for someone unaccustomed to it. Utilising common sense strategies such as translation 

services, learning the basics of the foreign language, and using multiple methods of communication 

such as video can overcome these language barriers. 

6. G e n d e r  B a r r i e r s  

Men and women are different, and while workplace relations between genders have improved 

astronomically over recent years, there are times when communications break down for one reason or 

another. Communication styles between genders are often different, which could cause problems 

between work colleagues, so it’s important to be respectful of each other. Effective communication 

can only be achieved between genders if everyone feels safe when offering their ideas and opinions. 

  

7. I n t e r p e r s o n a l   B a r r i e r s 

Poor self-esteem or an inability to make connections with others can prohibit us from actually 

communicating with our colleagues. This challenge can lead to withdrawal from the business 

dynamic, keeping your opinions and ideas to yourself and removing yourself from the workplace 

community. And because forcing yourself to communicate with others is the best way to overcome 

this barrier, it can be tough to break. Taking small steps by keeping your communications simple, 

listening to others and staying calm, will build self-confidence over time. 
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LECTURE 16 : OPERATING SYSTEM: EXAMPLES 

Operating System 
Operating system is a set of software that controls and manages hardware and basic system 
operations for a computer. The operating system loads programs into the computer's memory, 
runs these programs, and manages peripherals like disks and printers. 
Example: 

Disk Operating System (DOS)

 

Windows 

 

LINUX 

 

Mac 

UNIX 

 

  

Disk Operating System (DOS) 

 In the 1980s or early 1990s, the operating system that shipped with most PCs was a 
version of the Disk Operating System (DOS)created by Microsoft: MS-DOS. 

 MS-DOS is a disk-based, single-user, single-task and character based user interface 
(CUI) operating system. 

  

BS Publication

Telegram - https://t.me/AgroMind

https://t.me/AgroMind


Agri-Informatics Lecture Notes 
 

Prof. N. K. Kulkarni Page 105 
 

Go to MSDOS from Windows Operating System: 
Click Start Button à Choose Program à Choose Accessories à Click Command Prompt as 
shown below: 

 

Or Click Start Button à Choose Run à Type cmd in the Open tab as shown below: 

 
 

 

 Command Prompt will get displayed as shown: 
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The DOS commands can be entered in the command prompt and executed.  

WINDOWS 

 An operating system with a graphical user interface (GUI). 
 Graphical User Interface (GUI) is a user interface based on graphics (icons and 

pictures and menus) instead of text; uses a mouse as well as a keyboard as an input 
device) 

Versions 

 Windows 98 
 Windows Me 
 Windows NT 
 Windows 2000 
 Windows XP 
 Windows Server 2003 
 Windows Vista 
 Windows 7 
 Windows 8 
 Windows 10 

Desktop and its elements 

 In Windows operating system the basic working platform is the desktop. 
 It is also the opening screen of the Windows operating system. 
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 The desktop contains: 
o Taskbar 
o Icons 

Taskbar 

 Taskbar is usually a narrow strip present at the bottom of the screen. 
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WIindows XP Taskbar 

 

Windows Vista Taskbar 

 
 

 

Icons 

 Icons are small pictures/images representing applications. 
 Each icon has a label telling the name of the application it represents. 

 Example: 

 
Computer 

 lists the contents of  floppy disk, hard disk, CD-ROM drive, and 
mapped network drives 
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Network 

 locates shared resources on the entire network to which the computer 
is connected. 

 

Recycle Bin 

 stores deleted files, folders, graphics, and Web pages until you empty 
the bin.  

Internet Explorer 

 opens the browser internet explorer. 
 

Windows Explorer 
Windows Explorer is a file manager application used to view and manage drives, folders, and 
files. Windows Explorer can be opened by clicking on 
Start > My Computer or using the short cut key Windows + E while in Windows Xp  
Start > Computer or using the short cut key Windows + E while in Windows Vista. 
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